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Chapter 1

Chapter 1 - Getting Started with the Electronic Filing Status System®

The Electronic Filing Status System allows you to expand your professional services, file more
accurate returns, and get faster refunds for your clients.

The Electronic Filing Status System is internet-based; therefore, you need a valid CCH®

ProSystem fx® user ID established to use this system. User IDs are commonly referred to as Single
Sign-on or SSO IDs. Single Sign-on (SSO) allows users to log in to multiple CCH® ProSystem fx®

internet applications using the same user name and password.

Once a valid SSO ID is established and proper functional rights are granted, you can access the
Electronic Filing Status System and secured areas of the Support website on a 24/7 basis.

The Electronic Filing Status System provides the following options, and much more:

Export returns from Tax to the Electronic Filing Status System

Release returns over the internet directly to taxing authorities

Refer to status reports and support links

Submit EFINs for your firm's account numbers

Launch the Electronic Filing Status System from Tax to check a return’s status

Convenient 24/7 access to the Electronic Filing Status System

Send email reminders to clients who have not returned a completed Signature Form

Electronic filing data can be exported from Tax to the Electronic Filing Status System for all return
types except Estate & Gift. The data can then be released from the Electronic Filing Status System
to the appropriate taxing authorities. You must have the appropriate permission rights to
electronically file returns.

The following is an overview of the Tax Electronic Filing processing.

1. Enter your EFIN and Tracking Number in EFIN Manager.

2. Set electronic filing options for your firm and staff.

3. Review IRS publications 1345 (Individual) and 4163 (Business).

4. Prepare and qualify tax returns or extensions for electronic filing.

5. Export tax returns or extensions for electronic filing.

6. Obtain authorization form signatures.

7. Release tax returns or extensions to taxing authorities.

8. Check the status of the return or extension.
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If you have additional questions or need assistance, please contact Support.
1/7/2022, 1:40 PM
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Chapter 2

Chapter 2 - Configuring Electronic Filing Default Settings

You can set default values for tax return electronic filing options. In CCH ProSystem fx Tax, defaults
can be saved for each office group in Office Manager. If you have not done so previously, we
recommend you complete the following administrative tasks to prepare your firm and users for the
start of the electronic filing season:

Grant staff rights to export returns from Tax Preparation to the Electronic Filing Status System.

Add signer identification information to staff configuration.

Configure Office Manager for electronic filing preferences.

Link your desktop user IDs to your newly converted SSO IDs in Office Manager.

Note: You must have User Sign-on enabled on your desktop installation, and each user
ID must have a password.

Assigning Staff Electronic Filing Access
Before you can export returns for electronic filing and access the Electronic Filing Status System,
you must be granted functional rights. Functional rights for the Electronic Filing Status System
include releasing returns, deleting returns from the status system, changing the status of returns,
and stopping transmission of returns.

You can also assign these functional rights to a group. The main advantage of using groups is that
when any user is assigned to a group they automatically inherit that group’s rights. For many firms,
groups can provide a time-saving alternative for assigning functional rights. Staff members are not
restricted to the functional rights inherited from their designated group. They can be individually
assigned additional rights.

Note: You must be an administrator to assign electronic filing access.
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Instructions for CCH ProSystem fx Staff

To set up Electronic Filing access, do the following:

1. Log in to Configure Staff at admin.prosystemfx.com.

2. Click Staff to access Configure Staff.

3. Click Add at the bottom of the Staff home page. The General Information page displays.

4. Enter profile information in the required fields. For more information, click the Quick Start
Guide link at the top of the page, or to receive page-specific help, click the Question Mark icon
when present.

5. If your firm is using customized groups, select one from the Group drop-down list.

6. Enter additional user contact information as needed.

7. Click Next. The Licensing/Product Access page displays listing products for which your firm is
licensed.

8. Do one of the following:

To grant view-only access to the Electronic Filing Status System, select the
Electronic Filing Status box.

If you do not want this user to have access to the Electronic Filing Status System, click
Return to Staff Home to save any changes.

9. Click Functional Rights. To grant a user the ability to upload and release returns to the taxing
authority or give access to the Electronic Filing Status System, you must select the following
options in the Electronic Filing Status functional rights section.

10. Click the Expand/Collapse arrow located next to the Electronic Filing Status section to display
a list of options for which you can grant functional rights.

11. Select one or more of the following options:

Release returns to taxing authority

Delete returns from status system and also change status of returns to "paper
filed"

Stop returns from being transmitted to taxing authority

12. Do one of the following:

To select individual options, select the box in the Staff column adjacent to an option
for which you want to grant this user access.

To select all options, click the Select all link located above the listed options to give
this staff member access to all of the product’s features.

To deselect all options, click the Deselect all link located above the listed options to
remove all functional rights for this user.

Note: For each functional right, a Group and Staff column are displayed. If a staff
member is assigned to a group, check marks will display next to functional rights
associated with that group in both the Group and Staff columns. These fields
cannot be edited. You can only grant functional rights for product options this
member has not already acquired from his or her assigned group.
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13. Click Return to Staff Home. You will be returned to the Staff home page.

14. Repeat steps 3 through 12 for all applicable users.

Configuring Office Manager Electronic Filing Settings

Configure Staff

Instructions for CCH ProSystem fx

1. In Office Manager, click Configure Staff.

2. Select the desired user and click Setup.

3. In the Tax Preparation functional rights section, select Electronic filing - enable release of
return(s) to taxing authority if the staff should be allowed to upload tax returns to the
Electronic Filing Status System and release the return to the tax authority automatically.

4. Click the Tax Preparer tab.

5. In the Preparer identification section, enter the preparer's Electronic Return Originator (ERO)
PIN.

6. Click OK.

Configure Applications
The first step in preparing for e-filing processing is to configure the Office Manager application. Be
sure the current CCH ProSystem fx Tax version is installed on your system. We recommend the firm
administrator complete the following steps as supervisory access is required to link your CCH
ProSystem fx Tax user IDs with your SSO user IDs:

1. In Office Manager, select Configure Applications > Tax Preparation > Configure > "Office
Group" > Electronic Filing Options.

2. Review your options for the following for each office group:

General. Filing options

ERO. Filing options

Individual. Filing options, notification options

Partnership. Filing options, notification options

Corporation. Filing options, notification options

S Corporation. Filing options, notification options

Fiduciary. Filing options, notification options

Employee Benefit Plan. Filing options, notification options

Exempt Organization. Filing options, notification options

Configuring Electronic General Filing Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.
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3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - General dialog.

You can override these office group options on a per return basis using the General >
Electronic Filing > General worksheet (Interview Form EF-1).

Electronic filing identification number (EFIN)

EFIN number
Enter the Electronic Filing Identification Number assigned for electronic filing returns in this
office group. The EFIN is used for electronic filing processing for Individual, Partnership,
Corporation, S Corporation, Fiduciary, Employee Benefit Plan, and Exempt Organization
returns.

Vendor control number
Enter the 12-digit Vendor Control Number (VCN) that is assigned for electronically filing for all
returns except for Employee Benefit Plan. The VCNmust be associated with the EFIN number
entered above.

Notes:

You can override this in General > Electronic Filing > Electronic Return Originator -
Overrides > Vendor Control Number.

The EFIN and VCNmust both be entered in the same location (both for the office group
or both in the return). If only one is entered for the office group and one in the return,
disqualifying diagnostics may be issued in Tax Preparation.

Tell me more about Vendor Control Numbers.

A VCN is associated with a specific Electronic Filing Identification Number (EFIN) to
ensure that EFIN is not being used fraudulently by a preparer or firm that should not be
using it.

To view your firm's VCNs, do the following:

i. Open the Electronic Filing Status System (EFS).

ii. Select Admin > EFIN Manager from the toolbar. The VCN that is associated
with each of your firm's EFINs are listed in the EFIN Manager grid.

Taxpayer/Spouse PIN program information (1040 only)

Randomly generate the taxpayer and spouse PIN (1040 only)
Select this box to generate the taxpayer and spouse PINs for Individual returns.
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Electronic filing options

Print the entire government copy, rather than just forms that were not
included in the electronic file
Select this box to print the entire government copy of the return, and not just forms not included
in the electronic file.

Suppress printing of all forms during export
Select if you do not want forms printed in the government copy of the return.

Do not print nonfileable message on signature forms
Select if you do not want the nonfileable message to print on signature forms.

Note: You can override this option at the firm level on the Configure Firm > Options dialog.

Suppress printing of extension letters during export
Select if you do not want to print extension letters during export.

Do not update electronic filing status in return
When selected, the electronic filing status on the electronic filing status report within the return
and on the export dialog will not be updated with the latest information from CCH ProSystem fx
Electronic Filing System.

This option will not have a return level override.

Suppress printing of electronic filing and return results report
Select if you do not want to print the e-file history and return results report.

Note: This option applies to tax years 2020 and later.

6. Click OK when finished.

Configuring Electronic ERO Filing Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - ERO dialog.

The Electronic Return Originator (ERO) data is used to fill in the Declaration of Electronic
Originator (ERO) and Paid Preparer section on all applicable forms.

You can override these options on the General Electronic Filing worksheet (Interview Form
EF-2).
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Electronic Return Originator (ERO) information

ERO contact name
Enter the contact name.

Preparer e-mail address
Enter the preparer e-mail address. This is used as the "from" e-mail address when notifying the
taxpayer of the electronic filing acceptance via e-mail instead of by postcard. It is also used for
state purposes.

ERO PIN (all return types)
Enter the ERO PIN. For Individual returns, you may leave this field blank and select the
following box.

Randomly generate the ERO PIN
Select this box to have the ERO PIN randomly generated for Individual and Fiduciary returns.

Electronic Return Originator (ERO) overrides
Select the Replace signature block information with ERO overrides box to override the
signature block information. If you select this box, be sure to fill in all of the fields below this
box.

ERO name, address, city, state, ZIP code, country.
Enter the ERO firm name and all of the address information.

ERO EIN
Enter the ERO employer identification number.

ERO SSN
Enter the ERO social security number.

Alternate ERO ID no. (PTIN)
Enter an alternate ERO ID number.

PTIN is accurate and I am the registered owner
If you are the tax preparer and the PTIN information in this section belongs to you, select this
check box to confirm that the PTIN information is correct. The check box will only be enabled if
the PTIN is formatted correctly. As per the tax authority requirements, tax preparers must
verify their PTIN information before they can electronically file returns. This applies to tax years
2019 and later.
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Note: If the PTIN information for a tax preparer has not already been confirmed here, the
tax preparer is prompted to verify their information each time they navigate to this dialog.

ERO telephone number
Enter the ERO telephone number

Self-employed
Select this box to override self-employed information on the signature block.

6. Click OK when finished.

Configuring Electronic Individual Filing Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - Individual dialog.

Unless otherwise noted, you can override the following fields on the General > Electronic Filing
> General worksheet (Individual Interview Form EF-1).

What to file electronically

Electronically file federal return and enable electronic filing for selected
return types
If selected, electronic filing is activated for the federal return and selection is enabled for other
return types.

Extensions
If selected, all return extensions for the office group are filed electronically.

All state returns
If selected and electronic filing is available for that state, files all applicable returns
electronically.

All city returns
If selected and electronic filing is available for the city listed, files the city return electronically.

Other returns
If selected and electronic filing is available for other returns, files those returns electronically.
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Estimated tax payments
If selected and electronic filing is available, files the estimates electronically.

Federal elections with signatures required
If selected and electronic filing is available, electronically files federal elections that require
signatures.

Printing upon export

Suppress printing of taxpayer signature dates
If selected, suppresses the printing of signature dates on applicable returns.

Always produce 8879-SO during export
If selected, Form 8879-SO, State-Only e-file Signature Authorization, will be produced during
export. You can override this option in General > Electronic Filing > Print Options (Interview
Form EF-1, Box 62).

ERO signature options for Form 8879
Select one of the following from the drop-down list:

Suppress printing (default)

Print ERO firm name

Print ERO preparer

eSign options

Electronically sign authorization form(s)
Select this box to electronically sign authorization form(s).

Enable eSign if state returns do not qualify
If selected, users will be able to eSign the federal authorization form(s) even when the return
contains non-supported states.

Please refer to Appendix A in the eSign User Guide for a list of states that support eSign.

e-file paragraph in letters and filing instructions

Transmittal/filing instructions paragraph
Includes the transmittal letter and filing instructions paragraph. Available options are as
follows:

Not applicable (default)

Standard
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Alternate

Suppress

No further action

No further action - return Form 8879

The No further action option allows you to indicate in the transmittal letter/filing instructions
that the return has been filed electronically and no further contact is necessary.

Third party transmissions
If selected and electronic filing is available, an electronic data file will be created and
transmitted with third-party software.

6. Click OK when finished.

Note: If the e-file contains an extension, an email or postcard notification will be sent
automatically.

Configuring Electronic Partnership Filing Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - Partnership dialog.

Unless otherwise noted, you can override all of the following on the General > Electronic Filing
> General worksheet (Partnership Interview Form EF-1).

What to file electronically

Electronically file federal return and enable electronic filing for selected
return types
If selected, electronic filing is activated for the federal return and selection is enabled for other
return types.

Extensions
If selected, all return extensions for the office group are filed electronically.

All state returns
If selected and electronic filing is available for that state, files all applicable returns
electronically.

All city returns
If selected and electronic filing is available for the city listed, files the city return electronically.
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Other returns
If selected and electronic filing is available for other returns, files those returns electronically.

Composite returns
If selected and electronic filing is available for composite return, files those returns
electronically

Estimated tax payments
If selected and electronic filing is available, files the estimates electronically.

Federal elections with signatures required
If selected and electronic filing is available, electronically files federal elections that require
signatures.

Printing upon export

Always produce 8879-SO during export
If selected, Form 8879-SO, State-Only e-file Signature Authorization, will be produced during
export. You can override this option in General > Electronic Filing > Print Options (Interview
Form EF-1, Box 62).

ERO signature options for Form 8879
Select one of the following from the drop-down list:

Suppress printing (default)

Print ERO firm name

Print ERO preparer

e-file paragraph in letters and filing instructions

Transmittal/filing instructions paragraph
Includes the transmittal letter and filing instructions paragraph. The options are as follows:

Not applicable (default)

Standard

Alternate

Suppress

No further action

No Further action - return Form 8879-PE/8879-B

The No further action option allows you to indicate in the transmittal letter/filing instructions
that the return has been filed electronically and no further contact is necessary.
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For the text included with the various paragraphs, press F1 in the applicable box on General >
Electronic Filing > General (Interview Form EF-1).

Third party transmissions
If selected and electronic filing is available, an electronic data file will be created and
transmitted with third-party software.

Other options

Create New Jersey NJ-1080-C diskette file
Select to create Partnership NJ-1080-C diskette files. Partnership diskette filing will only be
applicable to returns for which the federal Partnership return is being electronically filed.

Create AR 1000CR magnetic file
Select to create the Arkansas partnership information (AR 1000CR) export file.

6. Click OK when finished.

Note: If the e-file contains an extension, an email or postcard notification will be sent
automatically.

Configuring Electronic Corporation Filing Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - Corporation dialog.

Unless otherwise noted, you can override all of the following on the General > Electronic Filing
> General worksheet (Corporation Interview Form EF-1).

What to file electronically

Electronically file federal return and enable electronic filing for selected
return types
If selected, electronic filing is activated for the federal return and selection is enabled for other
return types.

Extensions
If selected, all return extensions for the office group are filed electronically.
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All state returns
If selected and electronic filing is available for that state, files all applicable returns
electronically.

All city returns
If selected and electronic filing is available for the city listed, files the city return electronically.

Other returns
If selected and electronic filing is available for other returns, files those returns electronically.

Estimated tax payments
If selected and electronic filing is available, files the estimates electronically.

Federal elections with signatures required
If selected and electronic filing is available, electronically files federal elections that require
signatures.

Printing upon export

Always produce 8879-SO during export
If selected, Form 8879-SO, State-Only e-file Signature Authorization, will be produced during
export. You can override this option in General > Electronic Filing > Printing upon export >
Print 8879-SO during export (Interview Form EF-1, Box 62).

ERO signature options for Form 8879
Select one of the following from the drop-down list:

Suppress printing (default)

Print ERO firm name

Print ERO preparer

e-file paragraph in letters and filing instructions

Transmittal/filing instructions paragraph
Includes the transmittal letter and filing instructions paragraph. Available options are as
follows:

Not applicable (default)

Standard

Alternate

Suppress
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No further action

No further action - return Form 8879

The No further action option allows you to indicate in the transmittal letter/filing instructions
that the return has been filed electronically and no further contact is necessary.

Third party transmissions
If selected and electronic filing is available, an electronic data file will be created and
transmitted with third-party software.

6. Click OK when finished.

Configuring Electronic S Corporation Filing Options
1. Click Configure Applications.

2. Highlight Electronic Filing Options and click Setup.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Complete the fields on the Electronic Filing Options - S Corporation dialog.

5. Select Electronic Filing Options and click Setup.

6. Click OK when finished.

Unless otherwise noted, you can override all of the following on the General > Electronic Filing
> General worksheet (S Corporation Interview Form EF-1).

What to file electronically

Electronically file federal return and enable electronic filing for selected
return types
If selected, electronic filing is activated for the federal return and selection is enabled for other
return types.

Extensions
If selected, all return extensions for the office group are filed electronically.

All state returns
If selected and electronic filing is available for that state, files all applicable returns
electronically.

All city returns
If selected and electronic filing is available for the city listed, files the city return electronically.

Other returns
If selected and electronic filing is available for other returns, files those returns electronically.
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Composite returns
If selected and electronic filing is available for composite return, files those returns
electronically

Estimated tax payments
If selected and electronic filing is available, files the estimates electronically.

Federal elections with signatures required
If selected and electronic filing is available, electronically files federal elections that require
signatures.

Printing upon export

Always produce 8879-SO during export
If selected, Form 8879-SO, State-Only e-file Signature Authorization, will be produced during
export. You can override this option in General > Electronic Filing > Print Options (Interview
Form EF-1, Box 62).

ERO signature options for Form 8879
Select one of the following from the drop-down list:

Suppress printing (default)

Print ERO firm name

Print ERO preparer

e-file paragraph in letters and filing instructions

Transmittal/filing instructions paragraph
Includes the transmittal letter and filing instructions paragraph. Available options are as
follows:

Not applicable (default)

Standard

Alternate

Suppress

No further action

No further action - return Form 8879

The No further action option allows you to indicate in the transmittal letter/filing instructions
that the return has been filed electronically and no further contact is necessary.

For the text included with the various paragraphs, press F1 in the applicable box on General >
Electronic Filing > General (Interview Form EF-1).
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Third party transmissions
If selected and electronic filing is available, an electronic data file will be created and
transmitted with third-party software.

Other options

Create New Jersey NJ-1080-C diskette file
Select to create S Corporation NJ-1080-C diskette files. S Corporation diskette filing will only
be applicable to returns for which the federal S Corporation return is being electronically filed.

Create AR 1000CR magnetic file
Select to create the Arkansas S Corporation information (AR 1000CR) export file.

Configuring Electronic Fiduciary Filing Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - Fiduciary dialog.

Unless otherwise noted, you can override all of the following on the General > Electronic Filing
> General worksheet (Fiduciary Interview Form EF-1).

What to file electronically

Electronically file federal return and enable electronic filing for selected
return types
If selected, electronic filing is activated for the federal return and selection is enabled for other
return types.

Extensions
If selected, all return extensions for the office group are filed electronically.

All state returns
If selected and electronic filing is available for that state, files all applicable returns
electronically.

All city returns
If selected and electronic filing is available for that city, files all applicable returns
electronically. You can override this option in General > Electronic Filing > File All City
Returns.
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Note: This option applies to tax years 2021 and later.

Other returns
If selected and electronic filing is available for other returns, files those returns electronically.

Estimated tax payments
If selected and electronic filing is available, files the estimates electronically.

Federal elections with signatures required
If selected and electronic filing is available, electronically files federal elections that require
signatures.

Printing upon export

Always produce 8879-SO during export
If selected, Form 8879-SO, State-Only e-file Signature Authorization, will be produced during
export. You can override this option in General > Electronic Filing > Print Options (Interview
Form EF-1, Box 72).

ERO signature options for Form 8879
Select one of the following from the drop-down list:

Suppress printing (default)

Print ERO firm name

Print ERO preparer

e-file paragraph in letters and filing instructions

Transmittal/filing instructions paragraph
Includes the transmittal letter and filing instruction paragraph. The options are as follows:

Not applicable (default)

Standard

Alternate

Suppress

No further action

No further action - return Form 8879

For the text included with the various paragraphs, press F1 in the applicable box on General >
Electronic Filing > General (Interview Form EF-1).
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Third party transmissions
If selected and electronic filing is available, an electronic data file will be created and
transmitted with third-party software.

6. Click OK when finished.

Configuring Electronic Employee Benefit Plan Filing Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - Employee Benefit Plan dialog.

Unless otherwise noted, you can override all of the following on the General > Electronic Filing
> General worksheet (Employee Benefit Plan Form EF-1).

e-file paragraph in letters and filing instructions

Transmittal/filing instructions paragraph
Includes the transmittal letter and filing instructions paragraph. Available options are as
follows:

Not applicable (default)

Standard

Alternate

Suppress

No further action

The No further action option allows you to indicate in the transmittal letter/filing instructions
that the return has been filed electronically and no further contact is necessary.

Third party transmissions
If selected and electronic filing is available, an electronic data file will be created and
transmitted with third-party software.

For the text included with the various paragraphs, press F1 in the applicable box on General >
Electronic Filing > General (Interview Form EF-1).

6. Click OK when finished.

Configuring Electronic Exempt Organization Filing
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Select Electronic Filing Options and click Setup.

5. Complete the fields on the Electronic Filing Options - Exempt dialog.
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Unless otherwise noted, you can override all of the following on the General > Electronic Filing
> General worksheet (Exempt Interview Form EF-1).

What to file electronically
You can set the following electronic filing options:

Electronically file federal return and enable electronic filing for selected
return types
If selected, electronic filing is activated for the federal return and selection is enabled for other
return types.

Extensions
If selected, all return extensions for the office group are filed electronically.

All state returns
If selected and electronic filing is available for that state, files all applicable returns
electronically.

Estimated tax payments
If selected and electronic filing is available, files the estimates electronically.

Federal elections with signatures required
If selected and electronic filing is available, electronically files federal elections that require
signatures.

Printing upon export

Always produce 8879-SO during export
If selected, Form 8879-SO, State-Only e-file Signature Authorization, will be produced during
export. You can override this option in General > Electronic Filing > Print Options (Interview
Form EF-1, Box 62).

Note: This option is currently not used within the tax program.

ERO signature options for Form 8879
Select one of the following from the drop-down list:

Suppress printing (default)

Print ERO firm name

Print ERO preparer
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e-file paragraph in letters and filing instructions

Transmittal/filing instructions paragraph
Includes the transmittal letter and filing instructions paragraph. The options are as follows:

Not applicable (default)

Standard

Alternate

Suppress

No further action

No further action - send 8879-EO

The No further action option allows you to indicate in the transmittal letter/filing instructions
that the return has been filed electronically and no further contact is necessary.

For the text included with the various paragraphs, press F1 in the applicable box on General >
Electronic Filing > General (Interview Form EF-1).

Third party transmissions
If selected and electronic filing is available, an electronic data file will be created and
transmitted with third-party software.

6. Click OK when finished.

Configuring Electronic Individual Notification Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Highlight Electronic Filing Notifications and click Setup.

For existing office groups, previously configured values from the electronic filing option tabs
will be set as the default values on the new tabs.

Electronic Filing Notifications
E-mail notifications are free of charge. Postcard notifications are priced according to the latest
Pricing Catalog for each taxing authority in the return.

E-mail notifications or postcards are sent for each taxing authority. For example, if you have a
return for federal and four states, five e-mails or postcards will be sent. Each postcard will be
charged.

Electronic filing notification to client option
When you choose to notify your clients by e-mail, you are authorizing Wolters Kluwer to act on
your behalf and send e-mail notifications of taxing authority acceptance directly to your tax
clients. CCH-ReturnNotification@wolterskluwer.com will be listed in the “From” address.

Select one of the following for clients to receive notifications when returns or extensions are
accepted by a taxing authority:
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Notify all clients by e-mail

Notify all clients by postcard

Notify clients by postcard only if the e-mail address has not been input

Send no notification to tax clients

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all preparers by e-mail

Notify all preparers by postcard

Send no notifications to preparer

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing rejection notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
rejected by a taxing authority:

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send no notifications

Electronic filing stopped notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
stopped by the Tax system:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Electronic filing returns due to expire notification to preparer option
Most states require you to install the latest version of the Tax software within ten business
days of the deployment of the next release. When a software release contains an update for a
participating state, that state will not accept returns that are transmitted after the ten business
day limit. In this case, you must install the latest version, recalculate, and retransmit.

Select one of the following for preparers to receive notifications when returns are nearing
expiration due to the ten day limit:

Send no notifications (default)

Send e-mail to preparer
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Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Notes:

State returns that are not affected by the latest software update are not subject to
expiration.

You are unable to upload participating state returns that have expired to the Electronic
Filing Status System. In this case, you will be prompted to install the latest Tax
software.

For a list of participating states, go to our Knowledge Base and search for Which states
require the 10 Business Day Rule for electronic filing?

Number of days before expiration
This field is activated if any of the Send e-mail options have been selected. An e-mail will be
sent before expiration due to the ten day limit based on the number of days entered here. The
default number of days is 5.

Send notification to preparer when 8879 has not been received
If you select this box, an e-mail will be sent if Form 8879 has not been received within the
number of days specified below. The e-mail is sent to the specified address as follows:

a. To the address in the field E-mail address below, if input.

b. If an alternate address is not input in E-mail address, the e-mail is sent to the preparer
as designated on the return.

c. If neither of the above overrides are present, the e-mail is sent to the address that was
input in the Preparer e-mail address field on Electronic Filing Options > ERO tab.

Number of days after "Ready to Release"
This field is activated if Send notification to preparer when 8879 has not been received is
selected. An e-mail will be sent to the preparer if Form 8879 has not been received within the
number of days entered here. The default number of days is 3.

Notification Options

Send e-mail notification to e-mail address below in lieu of preparer
Select this box and enter an e-mail address in E-mail address to send the notification to an
alternate address. This box is active only if you selected Notify all preparers by e-mail or if you
have elected to receive notification for the 8879.

E-mail address. This field is enabled and you can enter an e-mail address when you have
made either of these selections:

If Notify all preparers by e-mail has been selected in the Electronic filing notification to
preparer option, and you have selected Send e-mail notification to e-mail address
below in lieu of preparer, an e-mail address is required here.
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If Send notification to preparer when 8879 has not been received has been selected,
you can enter an alternate e-mail address for the notification.

Note: If a notification option is selected and the type of notification and taxing authority are
not selected in the boxes below the e-mail address, the system will automatically select
Return for type and Federal for taxing authority.

Select the type of notification to be received

If a notification to a client or preparer has been selected, the check boxes for Return and
Extensions are enabled. Select one or both.

Select the taxing authority you want to receive notifications for

Check boxes for Federal, State/Cities and Report of Foreign Bank and Financial Accounts
(FBAR) are available for selection. Any combination may be selected, or only one, if preferred.

5. Click OK when finished.

Configuring Electronic Partnership Notification Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Highlight Electronic Filing Notifications and click Setup.

For existing office groups, previously configured values from the electronic filing option tabs
will be set as the default values on the new tabs.

Electronic Filing Notifications
E-mail notifications are free of charge. Postcard notifications are priced according to the latest
Pricing Catalog for each taxing authority in the return.

E-mail notifications or postcards are sent for each taxing authority. For example, if you have a
return for federal and four states, five e-mails or postcards will be sent. Each postcard will be
charged.

Electronic filing notification to client option
When you choose to notify your clients by e-mail, you are authorizing Wolters Kluwer to act on
your behalf and send e-mail notifications of taxing authority acceptance directly to your tax
clients. CCH-ReturnNotification@wolterskluwer.com will be listed in the “From” address.

Select one of the following for clients to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all clients by e-mail

Notify all clients by postcard

Notify clients by postcard only if the e-mail address has not been input

Send no notification to tax clients

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.
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Electronic filing notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all preparers by e-mail

Notify all preparers by postcard

Send no notifications to preparer

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing rejection notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
rejected by a taxing authority:

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send no notifications

Electronic filing stopped notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
stopped by the Tax system:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Electronic filing returns due to expire notification to preparer option
Most states require you to install the latest version of the Tax software within ten business
days of the deployment of the next release. When a software release contains an update for a
participating state, that state will not accept returns that are transmitted after the ten business
day limit. In this case, you must install the latest version, recalculate, and retransmit.

Select one of the following for preparers to receive notifications when returns are nearing
expiration due to the ten day limit:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate
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Notes:

State returns that are not affected by the latest software update are not subject to
expiration.

You are unable to upload participating state returns that have expired to the Electronic
Filing Status System. In this case, you will be prompted to install the latest Tax
software.

For a list of participating states, go to our Knowledge Base and search for Which states
require the 10 Business Day Rule for electronic filing?

Number of days before expiration
This field is activated if any of the Send e-mail options have been selected. An e-mail will be
sent before expiration due to the ten day limit based on the number of days entered here. The
default number of days is 5.

Send notification to preparer when 8879 has not been received
If you select this box, an e-mail will be sent if Form 8879 has not been received within the
number of days specified below. The e-mail is sent to the specified address as follows:

a. To the address in the field E-mail address below, if input.

b. If an alternate address is not input in E-mail address, the e-mail is sent to the preparer
as designated on the return.

c. If neither of the above overrides are present, the e-mail is sent to the address that was
input in the Preparer e-mail address field on Electronic Filing Options > ERO tab.

Number of days after "Ready to Release"
This field is activated if Send notification to preparer when 8879 has not been received is
selected. An e-mail will be sent to the preparer if Form 8879 has not been received within the
number of days entered here. The default number of days is 3.

Notification Options

Send e-mail notification to e-mail address below in lieu of preparer
Select this box and enter an e-mail address in E-mail address to send the notification to an
alternate address. This box is active only if you selected Notify all preparers by e-mail or if you
have elected to receive notification for the 8879.

E-mail address. This field is enabled and you can enter an e-mail address when you have
made either of these selections:

If Notify all preparers by e-mail has been selected in the Electronic filing notification to
preparer option, and you have selected Send e-mail notification to e-mail address
below in lieu of preparer, an e-mail address is required here.

If Send notification to preparer when 8879 has not been received has been selected,
you can enter an alternate e-mail address for the notification.
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Note: If a notification option is selected and the type of notification and taxing authority are
not selected in the boxes below the e-mail address, the system will automatically select
Return for type and Federal for taxing authority.

Select the type of notification to be received

If a notification to a client or preparer has been selected, the check boxes for Return and
Extensions are enabled. Select one or both.

Select the taxing authority you want to receive notifications for

Check boxes for Federal, State/Cities and Report of Foreign Bank and Financial Accounts
(FBAR) are available for selection. Any combination may be selected, or only one, if preferred.

5. Click OK when finished.

Configuring Electronic Corporation Notification Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Highlight Electronic Filing Notifications and click Setup.

For existing office groups, previously configured values from the electronic filing option tabs
will be set as the default values on the new tabs.

Electronic Filing Notifications
E-mail notifications are free of charge. Postcard notifications are priced according to the latest
Pricing Catalog for each taxing authority in the return.

E-mail notifications or postcards are sent for each taxing authority. For example, if you have a
return for federal and four states, five e-mails or postcards will be sent. Each postcard will be
charged.

Electronic filing notification to client option
When you choose to notify your clients by e-mail, you are authorizing Wolters Kluwer to act on
your behalf and send e-mail notifications of taxing authority acceptance directly to your tax
clients. CCH-ReturnNotification@wolterskluwer.com will be listed in the “From” address.

Select one of the following for clients to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all clients by e-mail

Notify all clients by postcard

Notify clients by postcard only if the e-mail address has not been input

Send no notification to tax clients

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.
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Electronic filing notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all preparers by e-mail

Notify all preparers by postcard

Send no notifications to preparer

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing rejection notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
rejected by a taxing authority:

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send no notifications

Electronic filing stopped notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
stopped by the Tax system:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Electronic filing returns due to expire notification to preparer option
Most states require you to install the latest version of the Tax software within ten business
days of the deployment of the next release. When a software release contains an update for a
participating state, that state will not accept returns that are transmitted after the ten business
day limit. In this case, you must install the latest version, recalculate, and retransmit.

Select one of the following for preparers to receive notifications when returns are nearing
expiration due to the ten day limit:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Chapter 2 - Configuring Electronic Filing Default Settings • 31



Notes:

State returns that are not affected by the latest software update are not subject to
expiration.

You are unable to upload participating state returns that have expired to the Electronic
Filing Status System. In this case, you will be prompted to install the latest Tax
software.

For a list of participating states, go to our Knowledge Base and search for Which states
require the 10 Business Day Rule for electronic filing?

Number of days before expiration
This field is activated if any of the Send e-mail options have been selected. An e-mail will be
sent before expiration due to the ten day limit based on the number of days entered here. The
default number of days is 5.

Send notification to preparer when 8879 has not been received
If you select this box, an e-mail will be sent if Form 8879 has not been received within the
number of days specified below. The e-mail is sent to the specified address as follows:

a. To the address in the field E-mail address below, if input.

b. If an alternate address is not input in E-mail address, the e-mail is sent to the preparer
as designated on the return.

c. If neither of the above overrides are present, the e-mail is sent to the address that was
input in the Preparer e-mail address field on Electronic Filing Options > ERO tab.

Number of days after "Ready to Release"
This field is activated if Send notification to preparer when 8879 has not been received is
selected. An e-mail will be sent to the preparer if Form 8879 has not been received within the
number of days entered here. The default number of days is 3.

Notification Options

Send e-mail notification to e-mail address below in lieu of preparer
Select this box and enter an e-mail address in E-mail address to send the notification to an
alternate address. This box is active only if you selected Notify all preparers by e-mail or if you
have elected to receive notification for the 8879.

E-mail address. This field is enabled and you can enter an e-mail address when you have
made either of these selections:

If Notify all preparers by e-mail has been selected in the Electronic filing notification to
preparer option, and you have selected Send e-mail notification to e-mail address
below in lieu of preparer, an e-mail address is required here.

If Send notification to preparer when 8879 has not been received has been selected,
you can enter an alternate e-mail address for the notification.
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Note: If a notification option is selected and the type of notification and taxing authority are
not selected in the boxes below the e-mail address, the system will automatically select
Return for type and Federal for taxing authority.

Select the type of notification to be received

If a notification to a client or preparer has been selected, the check boxes for Return and
Extensions are enabled. Select one or both.

Select the taxing authority you want to receive notifications for

Check boxes for Federal, State/Cities and Report of Foreign Bank and Financial Accounts
(FBAR) are available for selection. Any combination may be selected, or only one, if preferred.

5. Click OK when finished.

Configuring Electronic S Corporation Notification Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Highlight Electronic Filing Notifications and click Setup.

For existing office groups, previously configured values from the electronic filing option tabs
will be set as the default values on the new tabs.

Electronic Filing Notifications
E-mail notifications are free of charge. Postcard notifications are priced according to the latest
Pricing Catalog for each taxing authority in the return.

E-mail notifications or postcards are sent for each taxing authority. For example, if you have a
return for federal and four states, five e-mails or postcards will be sent. Each postcard will be
charged.

Electronic filing notification to client option
When you choose to notify your clients by e-mail, you are authorizing Wolters Kluwer to act on
your behalf and send e-mail notifications of taxing authority acceptance directly to your tax
clients. CCH-ReturnNotification@wolterskluwer.com will be listed in the “From” address.

Select one of the following for clients to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all clients by e-mail

Notify all clients by postcard

Notify clients by postcard only if the e-mail address has not been input

Send no notification to tax clients

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
accepted by a taxing authority:
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Notify all preparers by e-mail

Notify all preparers by postcard

Send no notifications to preparer

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing rejection notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
rejected by a taxing authority:

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send no notifications

Electronic filing stopped notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
stopped by the Tax system:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Electronic filing returns due to expire notification to preparer option
Most states require you to install the latest version of the Tax software within ten business
days of the deployment of the next release. When a software release contains an update for a
participating state, that state will not accept returns that are transmitted after the ten business
day limit. In this case, you must install the latest version, recalculate, and retransmit.

Select one of the following for preparers to receive notifications when returns are nearing
expiration due to the ten day limit:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate
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Notes:

State returns that are not affected by the latest software update are not subject to
expiration.

You are unable to upload participating state returns that have expired to the Electronic
Filing Status System. In this case, you will be prompted to install the latest Tax
software.

For a list of participating states, go to our Knowledge Base and search for Which states
require the 10 Business Day Rule for electronic filing?

Number of days before expiration
This field is activated if any of the Send e-mail options have been selected. An e-mail will be
sent before expiration due to the ten day limit based on the number of days entered here. The
default number of days is 5.

Send notification to preparer when 8879 has not been received
If you select this box, an e-mail will be sent if Form 8879 has not been received within the
number of days specified below. The e-mail is sent to the specified address as follows:

a. To the address in the field E-mail address below, if input.

b. If an alternate address is not input in E-mail address, the e-mail is sent to the preparer
as designated on the return.

c. If neither of the above overrides are present, the e-mail is sent to the address that was
input in the Preparer e-mail address field on Electronic Filing Options > ERO tab.

Number of days after "Ready to Release"
This field is activated if Send notification to preparer when 8879 has not been received is
selected. An e-mail will be sent to the preparer if Form 8879 has not been received within the
number of days entered here. The default number of days is 3.

Notification Options

Send e-mail notification to e-mail address below in lieu of preparer
Select this box and enter an e-mail address in E-mail address to send the notification to an
alternate address. This box is active only if you selected Notify all preparers by e-mail or if you
have elected to receive notification for the 8879.

E-mail address. This field is enabled and you can enter an e-mail address when you have
made either of these selections:

If Notify all preparers by e-mail has been selected in the Electronic filing notification to
preparer option, and you have selected Send e-mail notification to e-mail address
below in lieu of preparer, an e-mail address is required here.

If Send notification to preparer when 8879 has not been received has been selected,
you can enter an alternate e-mail address for the notification.
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Note: If a notification option is selected and the type of notification and taxing authority are
not selected in the boxes below the e-mail address, the system will automatically select
Return for type and Federal for taxing authority.

Select the type of notification to be received

If a notification to a client or preparer has been selected, the check boxes for Return and
Extensions are enabled. Select one or both.

Select the taxing authority you want to receive notifications for

Check boxes for Federal, State/Cities and Report of Foreign Bank and Financial Accounts
(FBAR) are available for selection. Any combination may be selected, or only one, if preferred.

5. Click OK when finished.

Configuring Electronic Fiduciary Notification Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Highlight Electronic Filing Notifications and click Setup.

For existing office groups, previously configured values from the electronic filing option tabs
will be set as the default values on the new tabs.

Electronic Filing Notifications
E-mail notifications are free of charge. Postcard notifications are priced according to the latest
Pricing Catalog for each taxing authority in the return.

E-mail notifications or postcards are sent for each taxing authority. For example, if you have a
return for federal and four states, five e-mails or postcards will be sent. Each postcard will be
charged.

Electronic filing notification to client option
When you choose to notify your clients by e-mail, you are authorizing Wolters Kluwer to act on
your behalf and send e-mail notifications of taxing authority acceptance directly to your tax
clients. CCH-ReturnNotification@wolterskluwer.com will be listed in the “From” address.

Select one of the following for clients to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all clients by e-mail

Notify all clients by postcard

Notify clients by postcard only if the e-mail address has not been input

Send no notification to tax clients

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
accepted by a taxing authority:
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Notify all preparers by e-mail

Notify all preparers by postcard

Send no notifications to preparer

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing rejection notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
rejected by a taxing authority:

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send no notifications

Electronic filing stopped notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
stopped by the Tax system:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Electronic filing returns due to expire notification to preparer option
Most states require you to install the latest version of the Tax software within ten business
days of the deployment of the next release. When a software release contains an update for a
participating state, that state will not accept returns that are transmitted after the ten business
day limit. In this case, you must install the latest version, recalculate, and retransmit.

Select one of the following for preparers to receive notifications when returns are nearing
expiration due to the ten day limit:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate
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Notes:

State returns that are not affected by the latest software update are not subject to
expiration.

You are unable to upload participating state returns that have expired to the Electronic
Filing Status System. In this case, you will be prompted to install the latest Tax
software.

For a list of participating states, go to our Knowledge Base and search for Which states
require the 10 Business Day Rule for electronic filing?

Number of days before expiration
This field is activated if any of the Send e-mail options have been selected. An e-mail will be
sent before expiration due to the ten day limit based on the number of days entered here. The
default number of days is 5.

Send notification to preparer when 8879 has not been received
If you select this box, an e-mail will be sent if Form 8879 has not been received within the
number of days specified below. The e-mail is sent to the specified address as follows:

a. To the address in the field E-mail address below, if input.

b. If an alternate address is not input in E-mail address, the e-mail is sent to the preparer
as designated on the return.

c. If neither of the above overrides are present, the e-mail is sent to the address that was
input in the Preparer e-mail address field on Electronic Filing Options > ERO tab.

Number of days after "Ready to Release"
This field is activated if Send notification to preparer when 8879 has not been received is
selected. An e-mail will be sent to the preparer if Form 8879 has not been received within the
number of days entered here. The default number of days is 3.

Notification Options

Send e-mail notification to e-mail address below in lieu of preparer
Select this box and enter an e-mail address in E-mail address to send the notification to an
alternate address. This box is active only if you selected Notify all preparers by e-mail or if you
have elected to receive notification for the 8879.

E-mail address. This field is enabled and you can enter an e-mail address when you have
made either of these selections:

If Notify all preparers by e-mail has been selected in the Electronic filing notification to
preparer option, and you have selected Send e-mail notification to e-mail address
below in lieu of preparer, an e-mail address is required here.

If Send notification to preparer when 8879 has not been received has been selected,
you can enter an alternate e-mail address for the notification.
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Note: If a notification option is selected and the type of notification and taxing authority are
not selected in the boxes below the e-mail address, the system will automatically select
Return for type and Federal for taxing authority.

Select the type of notification to be received

If a notification to a client or preparer has been selected, the check boxes for Return and
Extensions are enabled. Select one or both.

Select the taxing authority you want to receive notifications for

Check boxes for Federal, State/Cities and Report of Foreign Bank and Financial Accounts
(FBAR) are available for selection. Any combination may be selected, or only one, if preferred.

5. Click OK when finished.

Configuring Electronic Employee Benefit Plan Notification Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Highlight Electronic Filing Notifications and click Setup.

For existing office groups, previously configured values from the electronic filing option tabs
will be set as the default values on the new tabs.

Electronic Filing Notifications
E-mail notifications are free of charge. Postcard notifications are priced according to the latest
Pricing Catalog for each taxing authority in the return.

E-mail notifications or postcards are sent for each taxing authority. For example, if you have a
return for federal and four states, five e-mails or postcards will be sent. Each postcard will be
charged.

Electronic filing notification to client option
When you choose to notify your clients by e-mail, you are authorizing Wolters Kluwer to act on
your behalf and send e-mail notifications of taxing authority acceptance directly to your tax
clients. CCH-ReturnNotification@wolterskluwer.com will be listed in the “From” address.

Select one of the following for clients to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all clients by e-mail

Notify all clients by postcard

Notify clients by postcard only if the e-mail address has not been input

Send no notification to tax clients

Electronic filing notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
accepted by a taxing authority:
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Notify all preparers by e-mail

Notify all preparers by postcard

Send no notifications to preparer

Electronic filing rejection notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
rejected by a taxing authority:

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send no notifications

Electronic filing stopped notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
stopped by the Tax system:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send notification to preparer when 8879 has not been received
If you select this box, an e-mail will be sent if Form 8879 has not been received within the
number of days specified below. The e-mail is sent to the specified address as follows:

a. To the address in the field E-mail address below, if input.

b. If an alternate address is not input in E-mail address, the e-mail is sent to the preparer
as designated on the return.

c. If neither of the above overrides are present, the e-mail is sent to the address that was
input in the Preparer e-mail address field on Electronic Filing Options > ERO tab.

Number of days after "Ready to Release"
This field is activated if Send notification to preparer when 8879 has not been received is
selected. An e-mail will be sent to the preparer if Form 8879 has not been received within the
number of days entered here. The default number of days is 3.

Notification Options

Send e-mail notification to e-mail address below in lieu of preparer
Select this box and enter an e-mail address in E-mail address to send the notification to an
alternate address. This box is active only if you selected Notify all preparers by e-mail or if you
have elected to receive notification for the 8879.
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E-mail address. This field is enabled and you can enter an e-mail address when you have
made either of these selections:

If Notify all preparers by e-mail has been selected in the Electronic filing notification to
preparer option, and you have selected Send e-mail notification to e-mail address
below in lieu of preparer, an e-mail address is required here.

If Send notification to preparer when 8879 has not been received has been selected,
you can enter an alternate e-mail address for the notification.

Note: If a notification option is selected and the type of notification and taxing authority are
not selected in the boxes below the e-mail address, the system will automatically select
Return for type and Federal for taxing authority.

Select the type of notification to be received

If a notification to a client or preparer has been selected, the check box for Return is enabled.

Select the taxing authority you want to receive notifications for

If you want to receive a notification regarding the Federal return, select the Federal check box.

5. Click OK when finished.

Configuring Electronic Exempt Organization Notification Options
1. Click Configure Applications.

2. Highlight Tax Preparation and click Configure.

3. Select the office group for which you are establishing Electronic Filing options and click OK.

4. Highlight Electronic Filing Notifications and click Setup.

For existing office groups, previously configured values from the electronic filing option tabs
will be set as the default values on the new tabs.

Electronic Filing Notifications
E-mail notifications are free of charge. Postcard notifications are priced according to the latest
Pricing Catalog for each taxing authority in the return.

E-mail notifications or postcards are sent for each taxing authority. For example, if you have a
return for federal and four states, five e-mails or postcards will be sent. Each postcard will be
charged.

Electronic filing notification to client option
When you choose to notify your clients by e-mail, you are authorizing Wolters Kluwer to act on
your behalf and send e-mail notifications of taxing authority acceptance directly to your tax
clients. CCH-ReturnNotification@wolterskluwer.com will be listed in the “From” address.

Select one of the following for clients to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all clients by e-mail

Notify all clients by postcard

Notify clients by postcard only if the e-mail address has not been input

Send no notification to tax clients
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Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
accepted by a taxing authority:

Notify all preparers by e-mail

Notify all preparers by postcard

Send no notifications to preparer

Note: Notifications are not sent for MI or OH city returns or extensions acceptance.

Electronic filing rejection notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
rejected by a taxing authority:

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Send no notifications

Electronic filing stopped notification to preparer option
Select one of the following for preparers to receive notifications when returns or extensions are
stopped by the Tax system:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Electronic filing returns due to expire notification to preparer option
Most states require you to install the latest version of the Tax software within ten business
days of the deployment of the next release. When a software release contains an update for a
participating state, that state will not accept returns that are transmitted after the ten business
day limit. In this case, you must install the latest version, recalculate, and retransmit.

Select one of the following for preparers to receive notifications when returns are nearing
expiration due to the ten day limit:

Send no notifications (default)

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate
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Notes:

State returns that are not affected by the latest software update are not subject to
expiration.

You are unable to upload participating state returns that have expired to the Electronic
Filing Status System. In this case, you will be prompted to install the latest Tax
software.

For a list of participating states, go to our Knowledge Base and search for Which states
require the 10 Business Day Rule for electronic filing?

Number of days before expiration
This field is activated if any of the Send e-mail options have been selected. An e-mail will be
sent before expiration due to the ten day limit based on the number of days entered here. The
default number of days is 5.

Send notification to preparer when 8879 has not been received
If you select this box, an e-mail will be sent if Form 8879 has not been received within the
number of days specified below. The e-mail is sent to the specified address as follows:

a. To the address in the field E-mail address below, if input.

b. If an alternate address is not input in E-mail address, the e-mail is sent to the preparer
as designated on the return.

c. If neither of the above overrides are present, the e-mail is sent to the address that was
input in the Preparer e-mail address field on Electronic Filing Options > ERO tab.

Number of days after "Ready to Release"
This field is activated if Send notification to preparer when 8879 has not been received is
selected. An e-mail will be sent to the preparer if Form 8879 has not been received within the
number of days entered here. The default number of days is 3.

Notification Options

Send e-mail notification to e-mail address below in lieu of preparer
Select this box and enter an e-mail address in E-mail address to send the notification to an
alternate address. This box is active only if you selected Notify all preparers by e-mail or if you
have elected to receive notification for the 8879.

E-mail address. This field is enabled and you can enter an e-mail address when you have
made either of these selections:

If Notify all preparers by e-mail has been selected in the Electronic filing notification to
preparer option, and you have selected Send e-mail notification to e-mail address
below in lieu of preparer, an e-mail address is required here.

If Send notification to preparer when 8879 has not been received has been selected,
you can enter an alternate e-mail address for the notification.
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Note: If a notification option is selected and the type of notification and taxing authority are
not selected in the boxes below the e-mail address, the system will automatically select
Return for type and Federal for taxing authority.

Select the type of notification to be received

If a notification to a client or preparer has been selected, the check boxes for Return and
Extensions are enabled. Select one or both.

Select the taxing authority you want to receive notifications for

Check boxes for Federal, State/Cities and Report of Foreign Bank and Financial Accounts
(FBAR) are available for selection. Any combination may be selected, or only one, if preferred.

5. Click OK when finished.

Linking the Desktop User ID to the SSO Staff ID
In CCH ProSystem fx Tax, you have the option to launch the Electronic Filing Status system from
the Manage menu. To save time, if you link the desktop user ID to the SSO staff ID you will not need
to enter your SSO login information to access the Electronic Filing Status system.

Note: You must log in to Office Manager as a supervisor to assign the links. The system will
allow only a one-to-one association link. Linking several desktop users to a single SSO user is
not permitted.

1. In Office Manager, select Tools > Link SSO for Electronic Filing Status System. The Login to
Internet dialog displays.

2. Enter your SSO User ID and Password and click Login. The Link SSO for Electronic Filing
Status System dialog displays, which lists all desktop user IDs, including those already linked
to an SSO staff ID. Unlinked desktop IDs are blank in the Staff Name and Staff ID columns.

Note: Click the column headings to sort by that item.

3. Select the unlinked desktop user ID you want to link.

4. Click Link User to display the Select an SSO User dialog, which displays all SSO staff IDs that
are not currently linked to a desktop user ID.

5. Select the SSO user ID to link.

6. Click OK to save your selection and return to the Link SSO for Electronic Filing Status System
dialog.

7. Repeat steps 3 through 6 for any additional desktop IDs you want to link.

8. Click Close when you have finished linking IDs.

Removing the Desktop User ID - SSO Staff ID Link

1. In Office Manager, select Tools > Link SSO for Electronic Filing Status System. The Link
SSO for Electronic Filing Status System dialog displays.

2. Select the desktop user ID for which you want to remove the link.

3. Click Remove Link.
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4. Click Yes on the confirmation dialog to remove the link and return to the Link SSO for
Electronic Filing Status System dialog.

Printing the Desktop User ID - SSO Staff ID Link Report

1. In Office Manager, select Tools > Link SSO for Electronic Filing Status System. The Link
SSO for Electronic Filing Status System dialog displays.

2. Click Print. A report detailing the desktop user IDs - SSO staff ID links prints.
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Chapter 3

Chapter 3 - Preparing a Return or Extension Form for Electronic Filing

Before a return or extension form can be electronically filed, it must be designated and qualified for
e-filing in Tax.

Designating Returns or Extensions for Electronic Filing
Use the following forms or worksheets to designate a tax return or extension for electronic filing.
Worksheet, form, and field-level Help are available with instructions on completing each form or
worksheet.

Return Type Interview Form Worksheet

1040 Individual

Federal: EF-1,
EF-2, EF-3, EF-
4

Specialized
State: AL2

Federal: Federal > General >
Electronic Filing

Specialized State: Federal General >
Electronic Filing > Section 5

1065 Partnership, 1120 Corporation,
1120S S Corporation, 1041 Fiduciary

EF-1, EF-2 Federal > General > Electronic Filing

5500 Employee Benefit Plan (not
applicable for extensions)

Federal: EF-1,
EF-2

8955-SSA:
SSA-1, SSA 2

Federal: Federal > General >
Electronic Filing

8955-SSA: Federal > Other > 8955-
SSA - Stmt of separated Participants

990 Exempt Organization
EF-1, EF-1A,
EF-2

Federal > General > Electronic Filing

For information about setting default electronic filing settings in Office Manager, see Configuring
Electronic Filing Default Settings.
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Designating State Returns for Magnetic Media Electronic Filing
Use the following forms or worksheets to designate a state tax return for electronic filing. Form and
field-level Help are available with instructions on completing each form or worksheet.

State/Return Type Interview Form Worksheet

Arkansas / Partnership AR1 Federal > General > Electronic Filing > Section 4

Arkansas / S Corporation AR1 Federal > General > Electronic Filing > Section 4

New Jersey / Partnership NJ14 Federal > General > Electronic Filing > Section 4

New Jersey / S Corporation NJ14 Federal > General > Electronic Filing > Section 4

Qualifying Returns or Extension Forms
The Diagnostics report is an interactive report in Tax that lists the descriptions of errors and
warnings that could affect the accuracy of a prepared tax return. Electronic filing data should be
qualified using the Diagnostic report. If a return or extension form does not qualify, the reason is
identified in the report. Diagnostics are cleared from the report after errors or warnings are corrected,
the return is calculated, and the report is regenerated.

You can also review or print the Diagnostics report by selecting the Preparer Reports print option in
Tax.

Qualifying Returns for New Jersey Magnetic Media
Qualified New Jersey nonresident individuals can participate in a Composite Gross Income Tax
return, Form NJ-1080-C, and do not have to file their own income tax return with New Jersey,
provided that they meet certain criteria.
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Entities eligible to file composite returns on behalf of the above individuals are:

Professional Athletic teams

Partnerships

Limited Partnerships

Limited Liability Company

Estates & Trusts

New Jersey Electing S Corporation

The New Jersey Division of Taxation requires that the list of nonresident individuals (participants and
non-participants) listed in Form NJ-1080-C Sch A, NJ-1080-C Sch B, and NJ-1080-C Sch C for
Partnership and S Corporation return types to be filed with a Microsoft® Excel® file on diskette or re-
writable CD if there are 25 or more participants. The system provides a diagnostic when New Jersey
magnetic media is required for the return.

Links to the return, diskette, and Microsoft® Excel® file requirements are listed beside NJ-1080C -
Diskette Specifications Directory on the following New Jersey website:

http://www.state.nj.us/treasury/taxation/prntgit.shtml

The Federal > General > Electronic Filing > Section 4 worksheet State Electronic Filing option or the
return configuration set 1065/Partnership or 1120S/S Corporation electronic filing option, Create
New Jersey NJ-1080-C diskette file, must be selected.

Verifying PDF Attachments
Some return types require PDF attachments when electronically filing. Open the Federal > General
> Electronic Filing worksheet and verify if the required, optional, or both PDF attachments are
present in the worksheet sections relating to PDF Attachments.

See the following topics for more information:

About PDF Attachments in Electronically Filed Returns on page 50

Attaching PDF Files for Electronic Filing on page 51

Basic Rules for Electronic Filing
Review the following basic rules for electronic filing:

Returns must be designated and qualified before they can be electronically filed.

Personal Identification Numbers (PIN) are required by the IRS. Enter the taxpayer's and, if
appropriate, spouse's five digit PIN and the ERO PIN on Interview Form EF-1 or the General >
Electronic Filing worksheet.

All return information must be submitted electronically to be e-filed. You cannot use Individual
Forms 19, 20, or 21 to include manual forms or schedules.
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Dates Available to e-file
Electronic filing is available for the following 2021 returns:

Return Type Dates Available to e-file

Individual

Returns filed after e-file opens in early 2022

Form 4868 until April 18, 2022

Form 2350 until April 18, 2022

Partnership Returns filed after e-file opens in early 2022

Corporation Returns filed after e-file opens in early 2022

S Corporation Returns filed after e-file opens in early 2022

Fiduciary Returns filed after e-file opens in early 2022

Employee Benefit Plan Returns filed after forms release

Exempt Organization Returns filed after e-file opens in early 2022

Points to Remember
Individual Returns

The Electronic Filing Status System will not allow you to e-file a state only return after
transmitting the federal return, unless an entry is made on Interview Form EF-1 or the General
> Electronic Filing worksheet, indicating to not transmit the Federal return.

Partnership Returns

The general partner and signature authorization are required on Form 8879-PE. For
extensions, enter 2 to Print Form 7004 on Interview Form EXT-1, Box 30 or the Extensions >
Extensions worksheet. Form 8879-PE must be signed on or before the day of the electronic
transmission. (See IRS Publication 4163 for complete details on signatures required on Form
8879-PE.)

The New Jersey Division of Taxation requires Participant and Nonparticipant Directory
information (Form NJ-1080-C) to be filed on diskette when there are 25 or more participants.

The NJ-1080-C data file is stored in the X:\Wfx32\NJ1080C\20YY where X is the drive where
Tax is installed, and YY is the tax year of the return. The client ID consists of the file name with
an extension of *.NJP for Partnership returns and *.NJS for S Corporation. For filing purposes,
you can use Windows® Explorer to copy the file to diskette.

Note: The NJ-1080-C files are not deleted from the Wfx32\NJ1080C\20YY directory
automatically by the system. You must manually delete the files when they are no longer
needed.

Amended Partnership returns can be electronically filed.
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Fiduciary Returns

MeF is the only allowable format to transmit Fiduciary returns electronically.

Amended Fiduciary returns can be electronically filed.

Employee Benefit Plan Returns

The filing signer's Signature PIN and ID number are required on Interview Form EF-3 or the
General > Electronic Filing worksheet, under Signature Information. The filing signer(s) must
obtain their credentials (PIN and ID number) by registering with the DOL at
http://www.efast.dol.gov. They must have an EFAST2 PIN and ID, even if they already have a
PIN and ID for EFAST. These credentials may not be shared with anyone, including the
CPA/preparer. The client may enter this information remotely.

Amended Employee Benefit Plan returns can be electronically filed.

Form 4868

You are not required to mail the IRS, unless a balance due is being paid by check. The Taxpayer’s
PIN is only needed when an automatic withdrawal of payment is requested.

State Returns

Most states require you to install the latest version of the Tax software within ten business days of
the deployment of the next release. When a software release contains an update for a participating
state, that state will not accept returns that are transmitted after the ten business day limit. In this
case, the return is considered expired and you must install the latest version, recalculate, and
retransmit.

You can set the option for signers to receive notifications when returns are nearing expiration due to
the ten day limit, and then enter the number of days before expiration in Office Manager.

You can also filter returns that are nearing expiration in the Electronic Filing Status System.

Notes:

State returns that are not affected by the latest software update are not subject to expiration.

This state requirement does not apply to Employee Benefit Plan returns.

You are unable to upload participating state returns that have expired to the Electronic Filing
Status System. In this case, you will be prompted to recalculate the return.

For a list of participating states, go to our Knowledge Base and search for Which states can
expire for electronic filing?

About PDF Attachments in Electronically Filed Returns
Some return types require that you attach supporting documents as PDF files when you
electronically file a return. You can attach the PDF files using Interview Form EF-PDF1 or the
Federal > General Electronic Filing worksheet. The PDF files are embedded in the return so that you
can view them any time you access the return.
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During the electronic filing export process, a list of PDF file names, modified dates, categories
(Required or Optional), and associated forms displays. You can review the content of each PDF
before export.

Keep in mind the following requirements when attaching PDF files to a return:

Each PDF must have a unique name. If you attach a PDF with the same name as another PDF
that is already in the return, the first PDF will be overwritten.

The PDF files must not be password-protected.

The combined size of all PDF files attached to one electronic return submission cannot exceed
1 GB (roughly 5,000 pages).

Individual PDF files cannot exceed 60 MB (approximately 500 pages). Files in excess of this
size can be split into smaller PDF files.

Separate PDF files must be created for each form type (for example, one file for Forms 926,
one file for Forms 982).

PDF files with the same name can be attached to different occurrences in the return, provided
each has a unique attachment code.

Also, be aware that support of PDF attachments varies from state to state. Some states support only
required PDFs, some support both required and optional PDF attachments, and others do not
support PDF attachments at all.

Attaching PDF Files for Electronic Filing
Some return types require that you attach supporting documents as PDF files when you
electronically file a return. You can attach the PDF files using Interview Form EF-PDF1 or the
Federal > General > Electronic Filing worksheet. The PDF files are embedded in the return so that
you can view them any time you access the return.

To attach a PDF to a return for electronic filing, do the following:

1. Review the IRS and DOL requirements for required PDF attachments.

2. Open the return to be electronically filed.

3. Open one of the Federal > General > Electronic Filing worksheet sections or Interview Form
EF-PDF1 or, for 5500 returns, Form PDF-1 sections below.

Interview Forms

Return Type
PDF Attachment Sections on
EF-PDF1

Individual, Corporation, S Corporation, Partnership,
Employee Benefit Plan

PDF Attachments

Fiduciary
PDF Attachments: Specific
Forms

All Other PDF Attachments
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Interview Forms

Return Type
PDF Attachment Sections on
EF-PDF1

Exempt Organization

PDF Attachments: Specific
Forms

All Other Approved PDF
Attachments

Worksheet View

Return Type
PDF Attachment Sections on Worksheet Federal > General >
Electronic Filing

Individual Section 9 - PDF Attachments

Fiduciary
Section 7 - PDF Attachment - Required

Section 8 - PDF Attachment - Optional

Partnership Section 7 - PDF Attachments

Corporation,
S Corporation

Section 6 - PDF Attachments

Exempt
Organization

Section 6 - PDF Attachments - Specific Forms

Employee Benefit
Plan

Section 2 - PDF Attachments

Note: Section numbers for some return types vary slightly, depending on the tax year.

4. If needed, double-click the Code field and select the applicable attachment code. If you are
attaching a required PDF, the file name is automatically entered in the Attachment Name field.
If the PDF is optional, enter the IRS or DOL attachment name.

5. Double-click a blank PDF File Name box or, for Exempt Organization, Attachment Location
box.

Note: Only one PDF file can be attached to each section occurrence. If there are other
PDF files already attached, click Add at the top of the section to attach another PDF.

6. On the Attach File window, do one of the following:

Select Your machine or device to browse to and select a PDF from a location on your
machine or device, and then click Open.
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Select Document to list the available PDFs that are stored for the client in Document.
For clients that are not linked to Document, you are prompted to do so before
continuing. Browse to and select a PDF from a Document location, and then click
Open. PDF files for the return tax year display by default, if available, but you can
browse to another Document location, if needed.

Notes:

The following conditions must be met:

Document is licensed and installed.

You are assigned the necessary Document permissions.

Files that are downloaded from Document are saved only in the tax return and
not on your machine or device.

7. Select other applicable information in the PDF Attachments section, such as FS and State
codes. Specific information for states that use the FS and State boxes is included in the states'
instructions.

8. To attach another PDF, click Add at the top of the section, and then complete steps 4 - 7.

9. Save the return.

Notes: If you do not save the return, the PDF file is removed from the tax return.

Returns Ineligible for Electronic Filing

The following sections include common reasons a tax return is excluded from electronic filing.

Ineligible Individual Returns
This section lists common reasons a tax return is excluded from electronic filing. For additional
information, visit www.IRS.gov.

The IRS excludes certain returns from electronic filing:

Returns with a power of attorney currently in effect for the refund to be sent to a third party and
if Form 1310, Part 1, Boxes A and B, are present

Returns with a taxpayer Social Security Number not within the following ranges:

001-01-0001 – 665-99-9999

667-01-0001 – 899-99-9999

Returns including Form 2441, with the taxpayer or spouse showing no earned income

Returns with an entry on Form 4255 for the tax from property ceasing to be at risk

Returns with an overpaid windfall tax amount

Returns that require special consideration or procedures for completion, such as returns for
taxpayers who have received waivers from the IRS

Dual Status Form 1040NR cannot be electronically filed
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Tax has the following additional limitation: Manually calculated forms and schedules disqualify a
return. All the information must be accessible to the computer to transmit a correct return to the IRS.

Ineligible Partnership Returns
This section lists the most common reasons a Partnership tax return is excluded from electronic
filing. For additional information, refer to IRS Publications 4163 and 4164.

Returns with tax years ending prior to December 31, 2018

Returns granted approved waivers from electronic filing

Tax has the following additional limitation: Manually calculated forms and schedules disqualify a
return. All the information must be accessible to the computer to transmit a correct return to the IRS.

Ineligible Corporation/S Corporation Returns
The most common reasons a Corporation or S Corporation tax return is excluded from electronic
filing are listed below. For a complete list of ineligible returns, refer to IRS Publication 4163.

Returns covering multiple tax periods

Prompt assessment

Bank Holding Company Tax Act

Returns with tax periods ending prior to December 31, 2018

1120-L and 1120-PC standalone returns or Parent returns cannot be e-filed

Ineligible Fiduciary Returns
The most common reasons a Fiduciary tax return is excluded from electronic filing are listed below.
For a complete list of ineligible returns, refer to IRS Publication 1437.

Returns for part-year residents of a state, or cities associated with that state

Returns reporting liabilities for nonresident tax for cities associated with the particular state

Returns for decedents with Social Security Numbers NOT within the following ranges:

001-01-0001 - 699-99-9999

700-01-0001 - 733-99-9999

750-01-0001 - 763-99-9999

764-01-0001 - 899-99-9999

Returns with any dollar amount greater than $99,999,999,999

Returns with refund amounts equal to or greater than $1,000,000

Ineligible Employee Benefit Plan Returns
The most common reasons an Employee Benefit Plan tax return is excluded from electronic filing
are listed below. For additional information, refer to the DOL website.

Form 5558

Filings partially filed electronically and partially on paper
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Filings for which sections of the form are filed at different times rather than filed at the same
time

Unsigned filings; that is, filings submitted without including the PIN and Signer ID as an
electronic signature

Tax has the following additional limitation: You cannot attach files such as Microsoft®Word
documents, Microsoft® Excel® spreadsheets, or basic text files to your electronic file. PDFs are the
only attachments allowed.

Ineligible Exempt Organization Returns
The most common reasons an Exempt Organization tax return is excluded from electronic filing are
listed below. For additional information, please refer to IRS Publication 4163.

Filings from organizations not recognized as exempt (such as an application pending)

Filings showing a name change

Filings showing a change in accounting period

Filings using a non-U.S. return address (this applies only to Form 990-PF)

Filings with non-IRS forms attached or non-numbered attachments

Filings from organizations and government agencies that are excluded from the filing
requirement

Filings from short period returns (except for short period final returns)

Filings from private foundations in 60 month terminations
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Chapter 4

Chapter 4 - Exporting Returns and Extensions to Electronic Filing Status

Electronic filing data can be exported from Tax to the Electronic Filing Status System for all return
types except Estate & Gift. The data can then be released from the Electronic Filing Status System
to the appropriate taxing authorities. You must have the appropriate permission rights to
electronically file returns.

Once you designate and qualify a return or extension form for electronic filing and complete data
entry, you can export an electronic file to the Electronic Filing Status System. An export of a tax
return overwrites a previously exported file for that return.

For Example: A tax return uploaded with Federal, Alabama, and Wisconsin first and then the
same return uploaded with Federal and Alabama before the first one is released, Wisconsin will
not be sent.

See Chapter 3 - Preparing a Return or Extension Form for Electronic Filing on page 46 for
information about designating and qualifying returns.

During the export process, you have two methods of obtaining the taxpayer signature:

Paper Signature. Print the return signature forms to send to the taxpayer for a paper
signature.

Digital Signature. Send the return to CCH® eSign for a digital signature. For an overview
about CCH eSign interface, see The CCH® eSign Interface on page 59. For more detailed
information, see CCH® eSign Guides and References.

1. In Tax Preparation, click Calc  to calculate the return.

2. Check the return’s diagnostics to ensure that the return qualifies for electronic filing. If it does
not qualify, use the diagnostics to determine the reasons for disqualification. If the return
qualifies, it is prepared for release (authorization).

3. Select one of the following depending on the type of document you are exporting:

File > Export > Electronic Filing > Return

File > Export > Electronic Filing > Extension

File > Export > Electronic Filing > New York IT-204-LL

File > Export > Electronic Filing > Report of Foreign Bank and Financial Accounts

File > Export > Electronic Filing > 8955-SSA
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4. Select the return units to file electronically. Qualified units are selected by default. The units
that were previously filed electronically were refreshed with the current electronic filing
statuses when you opened the return.

Notes:

You cannot select returns with Disqualified and Not Available statuses and they do not
upload. But, they show in the Electronic Filing Status System so you can track the
remaining returns to be filed.

The Previous Electronic Filing Status column displays the status of the electronic file
and is updated when the return is opened and after the return is exported the first time.
If the return is exported multiple times, the Previous Electronic Filing Status column is
not updated until you close and reopen the return.

5. Do the following, if applicable:

If you are exporting an Individual return, select Send for eSign to request a digital
signature for authorization forms. The CCH eSign package consists of e-file signature
authorization forms, the client copy of the return, any user attached PDFs, and any
requested filing instructions. The CCH eSign package cannot exceed 20 MB or 2,000
pages. If the CCH eSign package exceeds 20 MB, you are given the option to exclude
user attached PDFs to reduce the file size. If the CCH eSign package exceeds 2,000
pages, return information cannot be sent to CCH eSign, regardless if the file size is
under 20 MB.

6. Click Export.

7. If there are no PDF files attached to the return, skip to step 8.

If PDF files are attached to the return (required for Corporation, S Corporation, Partnership, or
Exempt Organization returns), a list of PDF file names, modified dates, categories (Required
or Optional), and associated forms displays.

8. Click Export.

9. On the Electronic Filing Options dialog, select whether or not to print the forms you are
electronically filing.

If you do not want to print the forms, select Export to electronic filing only.

To export the forms for print, select Export to electronic filing and print, and then
select the print options.

i. Select a print destination.

ii. For PDF files only, choose the watermark to display in the print background.
The watermark options are Confidential, Copy, Do Not File, Draft, and File
Copy. Watermarks can be added or deleted by office group in Configure
Applications > Tax Preparation > Print Options from Office Manager.

iii. If you are not using TrueType fonts and are printing to a printer, click Load
Fonts to download fonts to the selected printer.

iv. Click OK. If you selected To PDF file or To PDF file and to printer, the Save
PDF Files As dialog displays. Do the following:
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a. If needed, change the folder where the PDF will be created, by entering
a location in the Save in field.

b. If needed, change the file name, by entering the file's new name in
the E-file Document field.

c. Click Save.

Note: If you click Cancel on the Electronic Filing Options dialog, the export and/or print for
electronic filing is canceled. No forms or files are produced. You must run the export
process again to electronically file and/or print this return.

10. Select your connection type from the list.

11. Select one of the following options:

Upload and hold. Uploads the selected return to the Electronic Filing Status System
and holds the return for manual release to the taxing authority.

Upload and release. Uploads the return to the Electronic Filing Status System and
releases the return to the taxing authority automatically.

Note: This option is not available if you selected Send for eSign.

Note: Most states require you to install the latest version of the Tax software within ten
business days of the deployment of the next release. When a software release contains an
update for a participating state, that state will not accept returns that are transmitted after
the ten business day limit. In this case, the return is considered expired and you must
calculate the return on the latest version.

12. Click Start. If signature forms have been prepared and you did not select Send for eSign, you
are prompted to print the required signature forms.

An IRS or DOL formatted file is created and uploaded. For Individual returns, a
fileable Form 8879 or authorization form prints. For Partnership, Corporation, S
Corporation, Fiduciary, and Exempt Organization returns, a fileable Form 8879-PE,
8453-PE, Form 8879-F, Form 8879-C, Form 8879-S, Form 8453-FE, or Form 8879-
EO prints.

After the IRS-formatted file is created, fileable Form 8879 or authorization forms can
be printed until the return is recalculated using the Selective Pages or Entire Return
print option in Tax.

If an electronic return is recalculated, a non-fileable message appears on the
respective Form 8879 or authorization form until you generate a new electronic return
file. An export of a tax return overwrites a previously exported file for that return.

Obtaining Authorization Form Signatures
Taxpayers and, if applicable, spouses must sign the following authorization forms before returns can
be released to taxing authorities:

Form 8879-PE or 8453-PE for a Partnership return

Form 8453-F or 8879-F for a Fiduciary return
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Form 8879-EO or 8453-EO for an Exempt Organization

Form 8879 for an Individual return

Forms 8879-C and 8879-S for Corporation and S Corporation returns

The taxpayer and ERO are required to sign a return with a PIN entered on the General > Electronic
Filing worksheet or Interview Form EF-1.

For Employee Benefit Plan returns, the General > Electronic Filing worksheet and Interview Form
EF-2 should contain PINs and EFAST2 IDs for the Administrator, Sponsor, and DFE, or the Service
Provider and a PDF scan of the signed signature page.

You have two methods of obtaining signatures:

Obtain paper signatures. Print the return signature forms to send to the taxpayer and, if
applicable, spouse for a paper signatures. You can print the authorization forms to obtain
paper signatures before or after exporting the return.

Obtain digital signatures. Send the return to CCH eSign to obtain digital signatures. This option
is provided during the export process. For more detailed information, see CCH eSign Guides
and References.

The CCH® eSign Interface
For 1040/Individual returns, you can upload the return and request a digital signature for
authorization forms. You can also request a digital signature for authorization forms for each
1040/Individual state that recognizes eSign as an acceptable signature method. Returns sent for
eSign can be tracked and are billed through the Electronic Filing Status System.

This option is only available if your firm is licensed for CCH® eSign, CCH® eSign account
information is configured in Firm Setup, and for the following conditions:

The option to electronically sign on the Electronic Filing Options window in Office Manager is
selected.

If a return contains a state that does not permit eSign and the disqualified overwrite option is
not utilized in Tax, that state must be exported separately for a paper signature.

The return is not amended, IT-204LL (New York), an extension, or a filing of Foreign Bank and
Financial Accounts (FBAR).

Create an electronic data file to be transmitted with third party software is not enabled on the
General > Electronic Filing > Electronic Filing Options worksheet.

Diagnostics are cleared for missing or invalid information.

Taxpayer name

Taxpayer email address

Taxpayer SSN

Spouse name (if filing jointly)

Spouse email address (if filing jointly, the spouse email address must be distinct from
the taxpayer email address)

Spouse SSN (if filing jointly)
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Taxpayer address

Firm name from the signature block, ERO, or return override information

ERO email address, signer's email address, or return override information

For complete information about setting up and managing an eSign account and a list of states that
allow eSign, see CCH® eSign Guides and References.

Tracking eSign Status
The Electronic Filing Status System tracks returns that are sent for eSign and the date signed
documents are received. When a return requesting eSign is uploaded for electronic filing, it is tagged
with the eSign icon. Upon completion of the signatures, the Signature Form-Received column is
automatically updated with the date of the signature. The date is shown in blue font. If the taxpayer
does not eSign and instead sends a paper signature, you can manually enter the date of receipt. The
manually entered date is shown in black font.

To prevent inadvertent releasing returns before a signature is received, the returns sent for eSign do
not show on the Release Returns tab until a date has been entered in the Signature Form-Received
column.
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Chapter 5

Chapter 5 - Using the Electronic Filing Status System

To access the Electronic Filing Status System, do any of the following:

From CCH ProSystem fx:

Click the Electronic Filing Status desktop icon located in the CCH ProSystem fx
program group.

From Tax Preparation, click the Electronic Filing Status icon on the Tax Preparation
toolbar, or select Manage > Electronic Filing Status. You can add this icon to your
toolbar by going to Options > Customize Toolbar.

Note: This application is not available to CCH ProSystem fx laptop systems.

To access directly from the internet, launch your web browser and go to efile.prosystemfx.com.

Notes:

You are required to log back in after 30 minutes of inactivity.

You must have a minimum resolution of 1024 x 768 to view the Electronic Filing Status System
properly.

Filtering and Searching for Returns
Locate returns using filters or search for returns for a specific client using the Filter/Search panel.
Click the up or down arrow to collapse or expand the panel.

Your filter or search results display in the grid. You can sort most columns in either ascending or
descending order and, if the returns exceed one page, use the right and left arrows below the grid to
display more results.

Filtering Returns
1. On the Filter panel, select any filtering criteria from the drop-down lists or options provided.

CCH ProSystem fx filters

Tax Year

Office

Office Groups
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Return Type

Date From and To*

Due to Expire**

Preparer

Federal, State, and/or FBAR

Exclude Returns on Extension

Show Returns with Signature Forms Not Received

Status

*Not available when you select a Due to Expire filter.

** Returns are considered expired if they are not calculated using the most current version
within 10 days of the version release date. If your firm uses the Upload and Hold option when
exporting returns from Tax, you may need to recalculate and export returns on the latest
version.

2. Click Go. The Federal Status and State Status columns show the status of the return or
extension.

Searching for a Single Client
1. On the Search panel, select a search method: Return ID, Name (Last, First), or SSN/FEIN (all

digits are required; hyphens are optional).

2. Enter the search criteria in the box.

3. Click Search. The Federal Status and State Status columns show the status of the return or
extension.

Icons Used in the Search Results List
Icon Description

Password protected return. To view the return history, you will be required to enter the
password to view all return history fields.

PDF attachment. This displays if a PDF file is attached to the return, and the return is a
Corporation, S Corporation, Partnership, or Exempt Organization.

Not Accepted. This return is either in a rejected or stopped status. For an FBAR return, this
indicates that further action is required for the return to remain timely filed.

Alert. This indicates that an alert has been applied to this return. For returns in accepted
status, the alert contains details provided by the taxing authority (IRS and/or State applicable).
For returns in another status, the alert may contain details provided by the system.

Stop Return. Within the Change Status page, the return may be stopped.

Delete Return. Within the Change Status page, the return may be deleted.

Paper Filed Return. Within the Change Status page, the return may be flagged as Paper
Filed.
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Icon Description

N/A. Within the Change Status page, the Paper Filed flag is not applicable for the return.

Return Type Identifiers Used in the Search Results List
Icon Return Type

Amended

eSign Selected

Estimated Payment

Final

Final Amended

Final Superseded

Short Year

Short Year Amended

Short Year Superseded

CCH Axcess™ Tax

Superseded

Multi-state with non-regular return or extension type(s)

Notes:

There are several reasons a return may not appear in the list: 

The return was not successfully exported for electronic filing.

The return was deleted.

The return was selected for eSign, and the 'Signature Form-Received' date column is
still blank (this applies to the Release Return(s) page only).

Extension type returns display in the grid with a different row color.
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At times, the text equivalent of an icon will appear instead of the icon, as follows:

(x), Amended

(f). Final

(fx). Final Amended

(fs). Final Superseded

(sy). Short-Year

(syx). Short-Year Amended

(sys). Short-Year Superseded

(s). Superseded

(i). Multi-state with non-regular return or extension type(s)

The product descriptions are as follows:

1040. Individual

1065. Partnership

1041. Fiduciary

1120. Corporation

1120S. S-Corporation

990. Exempt

5500. Employee Benefit Plan

4868/2350. Individual Extensions

7004P. Partnership Extensions

7004F/8868. Fiduciary Extensions

7004C. Corporation Extensions

7004S. S-Corporation Extensions

8868. Exempt Extensions

Customizing Grid Columns
You can customize and save your column preferences for the e-filing Status and Release Returns(s)
views. Your preferences are retained when you revisit each view or log back into the Electronic Filing
Status System.

See Column Descriptions for an explanation of the data displayed in each grid column.
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1. Click Select Columns on the toolbar. The View Preferences Page window displays.

2. Select desired page to apply preferences to.

e-filing Status tab

Release Return(s) tab

3. Do any of the following:

Add a column. Select a column for your view from the Available Columns list and click
the right-arrow. The following columns can be added to the custom view:

Account

Bank Acct Num
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Bank Info

Calc Version

Category

Elec Debit/Deposit

Elec Debit/Deposit Amt

FBAR

FBAR BSA ID (e-filing Status tab only)

FBAR Date

FBAR Status

Federal Date

Federal Due Date

Federal Status

Form 8453

Name

Notes

Preparer

Product

Refund/(Due)

Return Group

Sec. 965 Amount

Sec. 965 Bank Acct Num

Sec. 965 Debit Date

Signature Form - Received

Spouse Name

State Bank Info

State Category

State Date

State Elec Debit/Deposit

State Elec Debit/Deposit Amt

State Refund/(Due)

State Status

State Submission ID

Submission ID

Telephone Number

Year End

Order Columns. Select a column in the Selected Columns list and click the up or
down arrow.

Remove a column. Select a column in the Selected Columns list and click the left
arrow.
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Note: Return ID and State/Other are required columns and cannot be removed.

Restore Default View. Click Restore Default View to display the system's default
settings.

Account

Product

Preparer

Return ID

Name

Federal Status

Federal Date

Bank Info

State/Other

State Status

State Date

State Bank Info

4. Click Save Changes to retain your customized view.

Additional Information
Category and State Category. Displays additional information for the type of return.

FBAR BSA ID. This column is available for the e-filing Status tab only.

Form 8453. For Individual returns only. From the e-filing Status tab, when you click Forms
Attached in this column, the attachments/documents to be mailed display.

Notes. Read-only from the Release Return(s) tab. From the e-filing Status tab, do the following
to enter a form-free note:

a. Click the Notes icon and do either of the following:

Add a note. Enter text in the Notes pane and click OK.

Delete a note. Click Clear.

b. Click Save at the top of the grid to save the note.

Refund/(Due) and State Refund/(Due). Displays a refund amount or amount due.

Note: The amount is masked if the return is password protected.

Return Group. Return Group and Office Group are synonymous.

Return ID. This column is required.

Sec. 965. Displays the Federal Section 965 amount, the last four digits of the bank account
number, and the date for the payment.

Note: The amount and bank account information are masked if the return is password
protected.

Signature Form - Received. Read-only from the Release Return(s) tab. From the e-filing
Status tab, do the following:
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a. Enter the date the signed paper form is received from the taxpayer.

b. Click Save at the top of the grid to save the date, which displays in black font.

Upon completion of electronic signature(s) for a return requesting eSign, the Signature Form-
Received column is automatically updated in real time with the electronic signature date, which
displays in blue font. For a joint return, this is the date of the second (spouse) signature.

Note: If the return is selected for eSign and the Signature Form-Received date column is
blank, the return will not display in a Filter/Search on the Release Return(s) page.

State/Other. This column is required.

Printing and Exporting the Filter or Search Results List
After filtering or searching returns, you can print or export the results.

Do the following:

1. Log in to the Electronic Filing Status System.

2. Filter returns or perform a search, as described in Filtering and Searching for Returns on
page 61.

3. Do one of the following:

Click Print to print the results list to a printer or a PDF file. Column headers will only
print on the first page.

Click Export to export all grid headings and content to an XLS spreadsheet file. You
can then choose to reformat the exported data.

Notes:

The icons and return type identifiers listed in Filtering and Searching for Returns on page 61
are not included in the print output or export.

Depending on the number of columns, printing the results list may result in some of the
columns printing outside the page range. Printing in portrait or landscape works when the
column "default view" is selected. Otherwise, you may need to reduce the number of columns
to show all detail on one page.

Viewing, Printing, and Exporting Return History
Use this option to view, print, and export a return history including a detailed report for all activity
done on the client’s return. The following information for a return may display:

Heading Information

Product

Category (Federal; not displayed for Regular Return or Extension Types)

IRS Center

Name
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e-Postmark

FEIN (Business returns only)

Plan Number (5500 returns only)

Type of Notification sent

Fiscal Year Begin Date (when applicable)

Fiscal Year End Date (when applicable)

eSigned (date of the most recent electronic signature, when applicable)

IRS Message (when applicable)

Return Information

Date of Activity

Return ID (including the version; displays for the Upload Started activity)

Type of Activity

Submission ID

Refund/(Due)

Updated By

eSign Date (displays for the Transmitted status, when applicable)

ID Grid (when applicable)

ID

Status Date

Status

State/Other

State Category

FBAR

FBAR BSA ID

Note: Depending upon your access rights, some of the information may be unavailable.

To print or export the return history, do the following:

1. Log in to the Electronic Filing Status System.

2. Filter returns or perform a search, as described in Filtering and Searching for Returns on
page 61.

3. Click the Return ID for which you want to view the history.

4. If the return is password protected, click Enter Password to view all return history fields. Enter
the password and click OK.

5. You can do the following:

Review the activity done on the client's return.

Link to the Reject Report or Alert Report that provides an explanation and, if
applicable, solution to any exception that may occur. If a reject or alert was issued for
the return, a link to the corresponding report appears in the Type of Activity column.

Click Print to print the return history to a printer or a PDF file.
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Click Export to export the return history to an XLS spreadsheet file. You can then
choose to reformat and print the exported data.

Batch Printing and Exporting Return Histories
You can view, print, and export all return histories on a page using the Batch Export History button.
The return histories will include the same information listed in Viewing, Printing, and Exporting
Return History on page 68.

Note: Depending upon your access rights, some of the information may be unavailable.

To print or export the return history, do the following:

1. Log in to the Electronic Filing Status System.

2. Filter returns or perform a search, as described in Filtering and Searching for Returns on
page 61.

3. Click Batch Export History at the bottom-right of the screen.

Note: Password protected returns will not display sensitive information in the Return
Histories list unless the password was provided when looking at the individual return
history.

4. Do either of the following:

Review all the activity done on the client's returns.

Click Print to print all return histories to a printer or a PDF file.

Click Export to export all return histories to an XLS spreadsheet file. You can then
choose to reformat and print the exported data.

Tip: To avoid columns spanning across pages, set Landscape Orientation, Narrow Margins,
and Fit All Columns on One Page in Microsoft® Excel®Page Setup.

Changing the Status of a Return or Deleting a Return
Use this procedure to stop a return from being transmitted to the taxing authorities, or to delete a
return from the Electronic Filing Status System.

Note: If a return has a current status of Transmitted or Ready to Transmit, transmission of the
return cannot be reversed or halted.

1. Log in to the Electronic Filing Status System.

2. Click the Change Status tab. Returns with any status other than Accepted by Taxing
Authorities display.

3. Filter returns or perform a search, as described in Filtering and Searching for Returns on
page 61.
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4. Locate the file you want to stop transmission of or to delete, and do one of the following:

Click Stop to stop both the federal and state returns from being transmitted to the
taxing authority.

Click Paper if you will mail the return instead of filing electronically. (This option is
available for rejected returns only.)

a. Select each taxing authority return to be paper filed.

b. Click Paper File.

Click Delete to delete the selected return from the Electronic Filing Status System.
Use the delete option to remove a return that you are certain will never be released for
transmission to the IRS or DOL. (This option is not available for returns with a status
of Accepted or Transmitted.)

5. Click Yes on the confirmation window.

Notes:

If there is more than one page of returns, use the navigation arrows at the bottom of the page
to go to the additional pages.

First and previous pages. The left arrows display the first and previous pages.

Next and last pages. The right arrows display the next and last pages.

The options available will depend on your assigned rights.

If a return is deleted in error, it cannot be retrieved. It must be re-calculated and re-exported to
recreate the electronic file.

You can customize the columns on the Search Results View. See Customizing Grid Columns
on page 64.

Sending Signature Form e-mail Reminders
Use this tab to send an e-mail to clients who have not returned a completed Signature Form for the
rows selected.

An email reminder is sent if the following criteria are met:

A return has a status of Ready to Release by Customer.

The Signature Form – Received column is blank.

The Taxpayer email address is available.

To send reminders, do the following:

1. Log in to the Electronic Filing Status System.

2. Click the Reminder(s) tab. The Reminder Information window displays the returns that have
not received a Signature Form back from the client.

3. Select the rows that contain the returns you want to send a reminder for using one of the
following methods:

Select the box next to specific returns.

Click Select All to choose all of the returns displayed on the page.
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Click De-Select All to clear all of the returns displayed on the page.

Note: If there is more than one page of returns, use the navigation arrows at the
bottom of the page to go to the additional pages.

First and previous pages. The left arrows display the first and previous
pages.

Next and last pages. The right arrows display the next and last pages.

4. Click Send Reminder(s). The Reminder Results page displays, showing the number of
reminders successfully sent and the number of reminders selected but not sent.

Releasing a Return for Electronic Filing
Use this procedure to release a return for electronic filing. You must first export and upload the return
from Tax to the Electronic Filing Status System. See Chapter 4 - Exporting Returns and Extensions
to Electronic Filing Status on page 56 for more information.

To release returns to the taxing authority, if you did not choose the option Upload and release to tax
authority when creating the electronic file, do the following:

1. Log in to the Electronic Filing Status System.

2. Click the Release Return(s) tab.

3. Locate returns using filters or search for returns for a specific client using the Filter/Search
panel. Click the up or down arrow to collapse or expand the panel. See Filtering and Searching
for Returns on page 61 for more information.

4. Do any of the following:

Select returns to release using one of the following methods:

Select the box next to specific returns.

Click Select All Displayed to choose all returns displayed on the page.

Click De-Select All Displayed to clear all returns displayed on the page.

Note: If there is more than one page of returns, use the navigation
arrows at the bottom of the page to go to the additional pages.

First and previous pages. The left arrows display the first and
previous pages.

Next and last pages. The right arrows display the next and last
pages.

Click Print to print the results list to a printer or a PDF file. Column headers will only
print on the first page.

Click Export to export all grid headings and content to an XLS spreadsheet file. You
can then choose to reformat the exported data.
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Notes:

The icons and return type identifiers listed in Filtering and Searching for
Returns on page 61 are not included in the print output or export.

Depending on the number of columns, printing the results list may result in
some of the columns printing outside the page range. Printing in portrait or
landscape works when the column "default view" is selected. Otherwise, you
may need to reduce the number of columns to show all detail on one page.

5. Click Release Returns below the grid. The Release Information window displays only returns
with a current status of Ready to Release by Customer.

6. Do any of the following to change, print, or export your selected returns:

Select returns to release using one of the following methods:

Select the box next to specific returns.

Click De-Select All to clear all returns.

Click Select All to choose all returns.

Click Print to print the product, return ID, and name detail summary to a printer or PDF
file.

Click Export to save the product, return ID, and name detail summary in an XLS
spreadsheet file.

7. Click Release Returns(s) to immediately send the returns for transmission to the IRS or DOL.

8. Select the e-filing Status tab to view the status of your e-filed returns. See Checking Return e-
filing Status on page 78 for more information.

Notes:

Electronic Filing Status System transmissions to the IRS or DOL occur 24x7, minus scheduled
IRS maintenance windows.

Transmissions will commence when the IRS is ready to accept tax return data. For specific
start-up dates for Exempt, Fiduciary, Individual, Partnership, Corporation, and S Corporation
returns, please refer to updates at www.IRS.gov or from CCH Software News.

The DOL anticipates Employee Benefit Plan return processing will begin sometime after
January 1, 2022.

Accessing Electronic Filing Administration Tools and References
The Electronic Filing Status System provides direct links to our Customer Support site as well as
staff configuration and Electronic Filing Identification Number (EFIN) management. Click Admin on
the toolbar and select from the options below.
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Select Quick Look to review the availability of each tax product and taxing authority for the
different types of electronic filing, such as amended, consolidated, combined, extensions, and
magnetic filing. See Accessing ELF Quick Look for more information.

Select Support access our Customer Support site and search our Knowledge Base for
additional information.

Select Federal/State Reference to look up information for the e-file coordinator for each
taxing authority, as well as other general e-filing information.

Select Forms Release Status to look up information for the forms for each taxing authority,
such as form number, anticipated release available, and the current form status.

Select Configure Staff to review staff default settings. This option displays if you are granted
the functional right to configure staff.

Select EFIN Manager to manage EFIN data for your firm and view the associated Vendor
Control Numbers (VCNs).

Note: EFIN Manager is not listed on the Admin menu if the grid in the active tab is filtered
to display All offices.

See Using EFIN Manager for more information

Electronic Filing Guides
The Electronic Filing Support page includes links to the following electronic filing guides:

Electronic Filing Guide

Deadline Guide

Electronic Filing Consolidated and Other Returns Guide

Using EFIN Manager
The IRS assigns an Electronic Filing Identification Number (EFIN) to identify firms that have
completed the IRS e-file Application and are approved to be an authorized e-file provider. The EFIN
and associated Tracking Number are included in the e-file Application Summary on the IRS e-
Services site. After you enter these numbers in EFIN Manager and the IRS approves the
information, a VCN is assigned to the EFIN.
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Add. review, or edit the EFINs, Tracking Numbers, and VCNs that are assigned to your firm in the
Electronic Filing Status System using EFIN Manager.

Notes:

To access EFIN Manager, you must be granted the functional right to release returns from the
Electronic Filing Status System.

Tracking Number is a required number for electronic filing beginning with tax year 2017.

VCN is a required number for electronically filing Individual 1040 returns.

Adding EFIN Information

Note for CCH ProSystem fx : EFINs are associated with a firm's account number. In
CCH Axcess, all values in the Offices filter relate to the account number that you are logged in
with. For CCH ProSystem fx offices can be related to different account numbers. For this
reason, if you are a CCH ProSystem fxuser, you must first select a specific office on the
Filter/Search panel.

1. Select Admin > EFIN Manager from the toolbar.

2. Click Add EFIN on the EFIN Manager window.

3. Enter the EFIN that was assigned by the IRS to authorize electronic filing.

4. Enter the IRS Tracking Number associated with the EFIN.

5. Click Continue.

6. For verification, re-enter the EFIN and Tracking Number.

7. Click Confirm.

8. If your entries match, click OK to continue.

9. Select an eligible account number for the EFIN. You can select multiple account number boxes
for a single or multiple EFINs, if needed. You can also change the account number selection at
a later time.

Note: The account name that is associated with the account number(s) automatically
displays.

10. Click Save.

Note: Allow approximately 48 hours for the IRS to validate the EFIN. You can then access
EFIN Manager to find the VCN that will be associated with your EFIN.

Reviewing Your Firm's EFIN Information
EFIN Manager displays the following grid headings:

Heading Description

Active Determines if an EFIN is activated for use by the firm.

EFIN Lists the EFINs that were assigned by the IRS to authorize electronic filing.

Tracking
Number

Lists the IRS Tracking Number that is associated with each EFIN.
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Heading Description

Account
Number

Lists the firm account number that is associated with each EFIN. Multiple account numbers
can be associated to one EFIN. In the case of multiple accounts, you can click Multi in the
grid to show the associated numbers.

Account
Name

Lists the account name that is associated with each account number. In the case of
multiple accounts, you can click Multi in the grid to show the associated names.

Vendor
Control
Number

Lists the VCN that is associated with each EFIN. Each Individual (1040) return
electronically filed with a specific EFIN must include the associated VCN.

Update
Allows you to update the Active status and associated account number(s). You can also
select to hide or delete an inactive EFIN.

See Editing and Deleting EFIN Information below for more information.

EFIN Activity
You can view the name of the staff who added or last updated an EFIN so you can contact the staff, if
needed. Hover over any row on the EFIN Manager window to display the staff name.

Note: The activity displays for EFINs that are added or updated after 5/20/2018.

Editing and Deleting EFIN Information

1. Click Edit in the Update column on the EFIN Manager window to do any of the following:

Active
Change the status of an EFIN between Active and Inactive. An inactive EFIN
can be later re-activated, if needed.

Hide/Delete

Select to hide or delete an inactive EFIN. The Hide and Delete options are
available only after the Active box is cleared.

Warning: Deleted EFIN data cannot be restored.

Notes:

To delete an EFIN, you must have access to all accounts that it is
associated with.

If you select to hide an EFIN, you must also click Do not display hidden
EFINs on the EFIN Manager window to remove the EFIN from the grid
display.

Account
Number

Select a different value from the eligible account numbers for the EFIN. You can
select multiple account number boxes, if needed.

2. Click Save.

Note: The Last Update by column displays the name of the staff who added or last edited the
EFIN. This activity displays for EFINs that are added or updated after 5/20/2018.
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Additional Information
See more information about EFINs.

See more information about Vendor Control Numbers.

See information about entering the EFIN and VCN in Office Manager > Electronic Filing
Options.
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Chapter 6

Chapter 6 - After Transmitting the Return

After you have transmitted your return, you need to do the following:

Check the Return’s e-filing Status

Check Status Codes

View the Rejected Returns Report

View the Alert Report

Checking Return e-filing Status
The Electronic Filing Status System allows you to view and check the status of all your electronically
filed returns. Diagnostic and support tips in the Electronic Filing Status System explain any rejection
codes in clear terms.

To view the e-filing status for a return, perform a search as described in Filtering and Searching for
Returns on page 61. Review the e-filing status in the grid, located below the Filter/Search Panel.

If a return contains multiple units submitted for eSign, you can view the status and eSign date of
each unit in return history.

Notes:

If there is more than one page of returns, use the navigation arrows at the bottom of the page
to go to the additional pages.

First and previous pages. The left arrows display the first and previous pages.

Next and last pages. The right arrows display the next and last pages.

The Filter/Search Panel may be collapsed to allow presentation of more rows, per page. A
collapsed Filter/Search Panel may be expanded to make the panel once again visible.
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Status Codes
The following status codes are available within the Electronic Filing Status System:

Category: Not Released
Ready to Release by Customer. The return was uploaded and is ready to be released to the
IRS or DOL.

Upload Failed, please re-process. The file upload process failed to complete and the return
must be re-uploaded.

Upload Canceled. The file upload process has been canceled and the return must be re-
uploaded.

Upload Started. The file has been queued for upload to the server. This status should only
take a few seconds; if it takes longer, re-upload the return.

Category: Released
Released for Transmission - Validation in Progress. The return has been released for
transmission to the IRS or DOL and is being validated. Later verify if the return receives an
Accepted status.

Ready to Transmit - Validation Complete. The return has been released and validated and is
in the transmission process to the IRS or DOL.

Transmitted. The return has been transmitted and is awaiting acknowledgments from the IRS
or DOL.

Holding for Transmission - No Action Required by Customer. (Individual returns only) The
return is being held for legislature extensions or until the time transmission is allowed.

Category: Not Accepted

Sub-Category: Rejected

Rejected. The IRS or DOL has rejected the return for processing. See Viewing the Reject
Report on page 82 for more information. Make any necessary corrections, and then
recalculate, re-upload, and re-transmit the return.

Rejected by Federal, State Not Submitted. The return was rejected at the federal level with
no state level return being submitted.

Amendment Required – Timely filed. The Foreign Bank Account Report (FBAR) has been
accepted as timely filed with the Department of the Treasury; however, additional information
must be provided by the preparer to the Department of the Treasury within 30 days in order for
the return to remain timely filed.

Sub-Category: Stopped - Action Required

Paper Filing Required. If a return was rejected, you can change the status of the return to
Paper Filed from the Change Status window or in the Rejection Report. This section allows
you to indicate which taxing authority returns you will paper file.
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Stopped by Customer. If you stopped transmission of a return on the Change Status tab, the
Stopped by Customer status will display. See Changing the Status of a Return or Deleting a
Return on page 70 for more information. You may also receive this status for one of the
following reasons: if the state record is too large, because of a multi-state extension, a state
schema version change, or an incomplete transmission.

Stopped for IRS Schema Change. The return was stopped because IRS pre-defined rules
have changed. Recalculate the return on the newest version and re-upload the return.

Stopped by Support at Customer Request. The return was stopped because a client was not
able to do so.

Stopped: Recalc and Resubmit State-Only. The return was stopped because of a calculation
problem. Recalculate the return and submit it as a state-only record.

State Record is too Large, Resend as Federal Only. Processing was stopped due to the
excessive size of the state record. Reprocess only the federal return.

Stopped for State Schema Change. Processing of the return was stopped for a change to the
state schema.

Stopped: Please Recalculate on Latest Release. The return was stopped and must be
reprocessed on the latest release.

Transmission incomplete, please re-process. Transmission of the return failed to complete.
Reprocess the return.

Duplicate or Incorrect SSN, Correct and Resubmit. The return was stopped due to either a
duplicate or incorrect social security number. Correct the SSN and resubmit the return.

Incorrect EIN, Correct and Resubmit. The return was stopped due to either a duplicate or
incorrect employer identification number. Correct the EIN and resubmit the return.

Missing and Incorrect EFIN, Correct and Resubmit. The return was stopped due to either a
duplicate or incorrect EFIN. Correct the number and resubmit the return.

Return Canceled - Upload of Updated Return Failed from Tax. The previous upload of a
return was not released and a subsequent attempt to upload the same return has failed.

Disqualified or Not Yet Available for Filing. This return was exported with a state that was
disqualified or not approved. Resubmit the state only return when ready to electronically file.
This status is also available under category: Paper filed/Not e-filed.

EFIN Disallowed for e-filing. The EFIN utilized has not been provided to Wolters Kluwer, has
been deleted, is marked inactive, or a VCN has not been created. See Validate and Use an
Electronic Filing Identification Numbers (EFIN) on page 92 for more information.

EFIN Mismatch with VCN on File. The EFIN utilized is missing, does not match the EFIN in
EFIN Manager, or does not match the provided VCN. See Using EFIN Manager on page 74 for
information about viewing your firm's EFINs and associated VCNs.

Year Not Active per DOL. The DOL (Employee Benefit Plan Forms 5500 and 5500-SF) is not
allowing Tax Year 2018 forms to be filed on the 2018 Form versions starting January 1, 2021.
File Tax Year 2018 and prior returns on the 2020 Form version.
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Sub-Category: Stopped - CCH Reviewing

Stopped for CCH review. The return is being reviewed by Wolters Kluwer. After you receive
the review notification, re - upload the return. Contact Support for assistance as needed.

Byte Count Error. The return was stopped for review by Wolters Kluwer because of an
incorrect byte count. Recalculate, re-upload, and re-transmit the return.

Blank Form Error, PDF Error, Schema Validation Error, Missing State Information, Missing
or Incorrect ProSystem fx Account Number, Previous Upload in Process.

Category: Accepted
Accepted. The return has been accepted by the IRS or DOL for processing.

Conditional Acceptance. (Individual returns; certain states) When a state issues a conditional
acceptance, it allows the state additional time to do further processing to determine if
additional information is required. The state will sometimes send letters or notifications to ask
taxpayers for additional information. Once that additional information is supplied on paper by
the preparer/taxpayer, the state is able to officially accept the return and issue a new
acceptance acknowledgment.

State Notification - Additional Info Required. (Individual returns; certain states) For states
that issue a notification of missing information, such as Forms W-2, 1099 and 8453, the return
will not be processed by the state until the missing information is received.

Imperfect Return - Fix for Next Year. (Individual returns) The IRS will accept a previously
rejected return that has been rejected for Reject Code 501 or 504 (rejections for the dependent
Social Security Number) if Interview Form EF-2, Box 70 or the General > Electronic Filing
worksheet is marked. This alerts the IRS when they are processing the return the second time
that the taxpayer knows the SSN is incorrect, but wants to file electronically anyway. The IRS
will accept these returns, but they will display a status code of Imperfect Return. These returns
will go through additional checks with the IRS and the IRS may disallow the EIC credit or
dependent exemption for the dependent whose SSN is in question. Returns with this status will
take additional processing time at the IRS, causing the refund for the taxpayer to be delayed
up to four to six weeks.

Return Delivery Receipt. For certain Michigan and Ohio cities, a receipt of delivery of the
return to the city is received. This is not an official e-file acknowledgment. An alert will be
provided, containing a link to contact information for obtaining an official city acknowledgment.

 For additional information, refer to the following Knowledge Base articles:

Contact information for Michigan Cities

Contact information for Ohio Cities

Category: Paper Filed/Not e-filed
Paper Filed by Customer. The return must be paper filed. This status will prevent seeing
previous rejections.

Status Set to Paper Filed, as Customer Request. The return had its status set to paper filing
per the customer's request. This status will prevent seeing previous rejections.
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Extension Stopped - Return Already Accepted. The return has been accepted, but the
extension has not been sent.

Return Canceled at Customer Request. The return has been canceled by Wolters Kluwer at
the customer's request and the return will not be uploaded to the server.

Disqualified or Not Yet Available for Filing. The return was exported with a state that was
disqualified or not approved. Resubmit the state only return when ready to electronically file.
This status is also available under category: Not Accepted > Stopped - Action Required.

Viewing the Reject Report
To view the Reject Report for a return, do the following:

1. Log in to the Electronic Filing Status System.

2. Filter returns or perform a search, as described in Filtering and Searching for Returns on
page 61.

3. Click the link in the row of the return next to the Not Accepted indicator. If there are multiple
states, click the Multi link, and then click the link in the window. The Reject Report window
displays.

4. Do one of the following:

Click Export to export the report contents to an XLS spreadsheet file. You can then
choose to reformat and print the exported data.

Click Change status to paper filed to mail the return instead of filing electronically,
when applicable.

Note: If the return is password protected, click Enter Password to view all fields. Enter the
password and click OK.

After you have determined the reason for the rejection and fixed the return, recalculate and resubmit
the return electronically or by paper.

You are responsible for tracking and resolving rejected returns and for resubmitting the return
electronically or by paper. If a rejection is related to a transmission problem, the system will
retransmit the data until acceptance is achieved.

Notes:

You can also link to the Reject Report from the Type of Activity column in return history.

Failure to take action on a notification could result in the state return being rejected.

View the following topics for information on ineligible returns. For a complete listing of ineligible
return conditions, refer to http://www.irs.gov.

Individual

Partnership

Corporation/S Corporation

Fiduciary
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Employee Benefit Plan

Exempt Organization

Viewing the Alert Report
To view the Alert Report for a return, do the following:

1. Log in to the Electronic Filing Status System.

2. Filter returns or perform a search, as described in Filtering and Searching for Returns on
page 61.

3. Click the link in the row of the return next to the Alert indicator. If there are multiple states,
click the Multi link, and then click the link in the window. The Alert Report window displays.

4. Click Export to export the report contents to an XLS spreadsheet file. You can then choose to
reformat and print the exported data.

Note: If the return is password protected, click Enter Password to view all fields. Enter the
password and click OK.

For a complete listing of ineligible return conditions, refer to http://www.irs.gov.

Notes:

You can also link to the Alert Report from the Type of Activity column in return history.

Failure to take action on a notification could result in the state return being rejected.

An alert may also be contained within the Reject Report.

Viewing the Schema Validation Error Report
Taxing authorities use a schema, similar to a template, to designate where information goes in the
electronic file. When required information is missing or in a different format than the schema
requires, the return is stopped for a schema validation error.

Generally, partial data entries are the most common schema validation errors. The following
guidelines may prevent such errors:

Be sure to always enter complete addresses.

If you want None or N/A for a specific field, leave the field blank.

Avoid government form overrides.

Avoid using the special characters #, [, ], &, -, <, %, +, and /.

To view the Schema Validation Error Report for a return, do the following:

1. Log in to the Electronic Filing Status System.

2. Filter returns or perform a search, as described in Filtering and Searching for Returns on
page 61.
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3. Click the Schema Validation Error link in the row of the return. If there are multiple states, click
the Multi link, and then click the Schema Validation Error link in the window. The Schema
Validation Error Report window displays.

4. Click Export to export the report contents to an XLS spreadsheet file. You can then choose to
reformat and print the exported data.

Notes:

After you have determined the reason for the schema validation error and fixed the return,
recalculate and resubmit the return electronically or by paper.

You are responsible for tracking and resolving schema validation error returns and for
resubmitting the return electronically or by paper.

Electronic Filing Acknowledgment Status

Employee Benefit Plan
The EFAST2 system, on behalf of the DOL, provides an acknowledgement for processable filings as
soon as they are received and the acknowledgement is sent back to the software provider.

The status of a filing is available within 20 minutes of submission of the filing. Filers must make
corrections electronically by submitting an amended filing.

The IRS system which handles Form 8955-SSA electronic filing can take up to 14 calendar
days to return an acknowledgment.

Please refer to online FAQs 35 through 40 at
https://www.dol.gov/sites/dolgov/files/EBSA/about-ebsa/our-activities/resource-
center/faqs/efast2-form-5500-processing.pdf.

The EFAST2 Quick Start Guide also contains information regarding submissions to the
EFAST2 system. The guide is available from the Help menu on the efast.dol.gov website.

All Other Tax Products
IRS acceptance of the transmission indicates that the electronic filing process was successful and,
in all probability, will proceed as expected. An IRS acceptance acknowledgment is usually issued
from 24 to 48 hours after sending the return.

Notifications
Office Manager in CCH ProSystem fx Tax offers the following options to set defaults for receiving
electronic filing status notifications:
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Electronic Filing Status - Accepted

Electronic filing notification to client option. Select one of the following for clients to receive
notifications when returns or extensions are accepted by a taxing authority:

Notify all clients by email

Notify all clients by postcard

Notify clients by postcard only if the email address has not been input

Send no notification to tax clients

Electronic filing notification to preparer option. Select one of the following for preparers to
receive notifications when returns or extensions are accepted by a taxing authority:

Notify all preparers by email

Notify all preparers by postcard

Send no notification to preparer

Electronic Filing Status - Rejected

Electronic filing rejection notification to preparer option. Select one of the following for
preparers to receive notifications when returns or extensions are rejected by a taxing authority:

Send no notifications

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Electronic Filing Status - Stopped

Electronic filing stopped notification to preparer option. Select one of the following for
preparers to receive notifications when returns or extensions are stopped by the Tax system:

Send no notifications

Send e-mail to preparer

Send e-mail to alternate preparer e-mail address

Send e-mail to both preparer and alternate

Email notifications are free of charge. Since email provides more space than a postcard, emailed
notifications for Individual clients contain more information from Form 9325, such as how to check on
the status of the refund, the date the return was accepted by the IRS, and the IRS service center to
which the return was transmitted. Therefore, your clients will have fewer questions for you
concerning their e-filed returns. Postcard notifications are priced according to the latest Pricing
Catalog. Email notifications and postcards are sent for each taxing authority. For example, if you
have a return for federal and four states, five emails or postcards will be sent. Each postcard will be
charged.

For more information about electronic filing status codes and options, see the following:

Accepted, Rejected, and Stopped statuses. Status Codes on page 79

CCH Axcess return configuration set. Managing Signer and Return Configuration Set
Electronic Filing Settings
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ProSystem fx Office Manager. Configuring Office Manager Electronic Filing Settings on
page 8

Mailing Forms to the IRS
Within three business days after an Individual return is accepted by the IRS, you must batch any
required Forms 8453 and submit them to the appropriate electronic filing IRS service center. To
avoid facing penalties and/or suspension from the electronic filing program, make sure you comply
with the following IRS requirements:

Maintain copies of all Forms 8453 you submit. The IRS suggests, though it is not required, that
you also keep copies of all appropriate attachments.

Ensure that all Forms 8453 are fully and correctly completed.

Ensure that all appropriate attachments are included.

Ship the forms within three business days after acceptance to:

Internal Revenue Service

Attn: Shipping and Receiving, 0254

Receipt and Control Branch

Austin, TX 73344-0254

Note: The Employee Benefit Plan return is entirely paperless for Forms 5500 and 5500-SF;
therefore, you are not required to mail any forms.

Receiving Refunds for Individual Returns
Certain liability conditions may cause a refund amount to be offset after the Individual return has
been accepted. The IRS acknowledgment will contain information if any of the following conditions
exist:

Delinquent Federal tax

Delinquent state tax

Delinquent student loan

Delinquent child support

Back payments owed to other states and/or Federal agencies

Data related to outstanding debts will be displayed under return history in the Electronic Filing Status
System.

You should tell taxpayers how to follow up on returns and refunds by pointing out the Where’s My
Refund feature on IRS.gov. If taxpayers do not have access to the internet, then you should provide
taxpayers with the IRS Tele-Tax return information number, (800) 829-4477. Either of these options
gives the date of depositing or mailing of their refund.

Before checking on refunds, taxpayers should wait at least three weeks from the time the IRS
acknowledges acceptance of the return data. Because the IRS updates refund information each
weekend, taxpayers should be advised to check only once a week to avoid checking with no
possibility of success.
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To check on refunds, taxpayers need to enter the first Social Security Number shown on their tax
return, the filing status and the exact amount of the refund in whole dollars.

If taxpayers do not receive their direct deposit within one week (or refund check within 30 days) of
the date given, they may call the Refund Hotline number at (800) 829-1954, which has information
about taxpayers’ refunds (when it becomes available).

Because of disclosure laws, the IRS cannot provide information through Tax regarding refund delays
or reasons the refund cannot be honored as a direct deposit. Likewise, the IRS cannot provide this
information to the practitioner unless a current power of attorney is on file at the IRS. The client will
need to contact the IRS for detailed information regarding offsets and delays.

Individual Balance Due Returns
For balance due returns filed electronically, Form 1040-V, Payment Voucher, must accompany the
payment, which prints upon export if paying by check. The mailing address for e-filed returns is, in
most cases, different than paper returns. Refer to the instructions for Form 1040-V or the transmittal
letter and filing instructions generated by Tax, which reference the correct mailing address.

Electronic Funds Withdrawal is available to pay a balance due for e-filed returns. Basic Data
worksheet > Direct Deposit/Electronic Funds Withdrawal section (BNK-1) is used to make the
necessary entries to use Electronic Funds Withdrawal.

Invoice Abbreviations
You will see the following abbreviations on your invoice for items electronically filed.

Abbreviations for Types of Return

Abbreviation For Type of Return

AME Amended

EXT Extension

FAM Final - Amended

FIN Final

FSU Final - Superseded

REG Regular

SUP Superseded

SYA Short-Year – Amended

SYR Short-Year

SYS Short-Year – Superseded
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Abbreviations for Categories of Returns

Abbreviation For Category of Return

104A 1040A

104E 1040EZ

104N 1040NR

AEXT Additional Extension

BIRI 1040 Business Income and Receipts Tax

BPTI 1040 Initial Privilege Tax

BPTX Initial Privilege Tax

C199 CA 199

C568 CA 568

CBT1 NJ CBT

CLOS Closing Certificate

COMB Combined

COMP Composite

CONR Composite-Non Resident

CONS Consolidated

CTAC CT-3-A/C

CTAX Corporate Income Tax

DISE Disregarded Entities

FBAR Foreign Bank Account Report

FRAN Franchise

FRPY Franchise Prior Year

FSCL Fiscal

INFO Information Return

K108 KC MO RD108

K109 KC MO RD109

K18S KC MO RD108 Spouse
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Abbreviation For Category of Return

K19S KCMO RD109 Spouse

LLCP LLC-LLP Payment

MA2G MA Form 2G

N210 NYC 210

NJ10 NJ Part-100

NPTI 1040 Net Profits Tax

NPTX Net Profits Tax

ORLS OR LTD Self-Employment Spouse

ORLT OR LTD Self-Employment

ORTM OR TriMet Self-Employment

ORTS OR TriMet Self-Employment Spouse

PASS Pass-Through Entity

PPTI 1040 Business Privilege Tax

PPTX Business Privilege Tax

PRIO Prior Year

PROP Property Tax

RCT1 1040 RCT-101

SITI PHI PA 1040 School Income Tax

SPOU Spouse Return

SPPY Spouse Prior Year

SPV1 Spouse Voucher-Payment 1

SPV2 Spouse Voucher-Payment 2

SPV3 Spouse Voucher-Payment 3

SPV4 Spouse Voucher-Payment 4

T104 TX Franchise

T170 TN FAE170
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Abbreviation For Category of Return

T173 TN FAE173

T183 TN FAE183

T1PY TX Prior Year

T1NY TX Next Year Extension

TECH Technical Termination

TXRP Tax Report

VOU1 Voucher-Payment 1

VOU2 Voucher-Payment 2

VOU3 Voucher-Payment 3

VOU4 Voucher-Payment 4

VOUC Voucher-Filing Fee

1127 NYC-1127

112S NYC-1127 Spouse

2350 2350

9TEX 990-T Extension

9TAE 990-T Additional Extension

47EX 4720 Extension

47AE 4720 Additional Extension

8955 8955-SSA

Sample Abbreviations with Descriptions

Sample Abbreviation Sample Description

REG Regular type of return

AME Amended type of return

REG LLCP Regular type, LLC-LLP Payment category

AME COMP Amended type, Composite category

REG ANDOVER Regular type, for the City of Andover
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Chapter 7

Chapter 7 - Common Questions

Non-receipt of IRS Acknowledgment
Question: I released a return for transmission to the IRS and transmitted it and have not received an
acknowledgment. When can I expect to receive it?

Answer: Check the Electronic Filing Status System. If the return status is still showing the Ready to
Release status, it did not get released or transmitted. It takes 24 to 48 hours to receive an
acknowledgment from the IRS. If this answer does not fit your situation, call the Electronic Filing
Support staff at 1-800-739-9998, option 3.

Reprocess Returns
Question: I reprocessed a rejected return and received a new Form 8453. I had already submitted
the original form to the IRS. What do I do?

Answer: Do not mail Form 8453 for any tax system to the IRS unless you are certain that the return
has been accepted for processing by the IRS.

If you have already mailed Form 8453 and have a rejected return, you must contact the IRS. In most
cases you can write a letter explaining that you inadvertently sent the wrong form to the IRS. If you
continue to submit Form 8453 on rejected returns, the IRS will probably contact you.

Become an Authorized e-File Provider
Question: How do I become an authorized e-file provider and obtain an Electronic Filing
Identification Number (EFIN) for my firm?

Answer: Effective October 1, 2012, the IRS no longer accepts Form 8633, Application to Participate
in the IRS e-file Program. You must submit the IRS e-File Application to become an IRS e-file
provider. After the IRS approves the application, the IRS sends an acceptance letter, which includes
the EFIN.

Go to the Become an Authorized e-file Provider IRS page to see the steps to submit the IRS e-File
Application.
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Note: In addition, modifications to existing account information must be completed using e-
Services on the IRS website.

Validate and Use an Electronic Filing Identification Numbers
(EFIN)

Question: I received my firm's EFIN. What do I do now?

Answer: You must first register the EFIN and the associated Tracking Number with Wolters Kluwer.
After approximately 48 hours, Wolters Kluwer assigns a VCN to the EFIN. Your firm can then enter
the EFIN and VCN numbers in the Electronic Filing sections for an office group in Office Manager, or
in a return.

The following steps are required:

1. Obtain the EFIN and Tracking Number. Both the EFIN and Tracking Number are included in
the e-file Application Summary on the IRS e-Services site.

2. Enter the EFIN and Tracking Number in EFIN Manager. Allow approximately 48 hours for the
IRS to validate the EFIN, after which, a VCN is assigned.

3. Obtain the VCN from EFIN Manager.

4. Enter the EFIN and VCN in Office Manager > Electronic Filing Options or the Return
Configuration Set > Electronic Filing Options.

Additional Information
IRS EFIN FAQs

About the Vendor Control Number (VCN) on page 94

Obtain the Firm's EFIN and Tracking Number
Question: I must enter the EFIN and associated Tracking Number for my firm in EFIN Manager. How
do I obtain these numbers?

Answer: To electronically file returns, your firm must obtain the Electronic Filing Identification
Number (EFIN) and, beginning with tax year 2017, the associated Tracking Number from the IRS e-
Services site. Your firm must first submit your e-file Application to become an authorized IRS e-file
provider.

After submitting the application and the IRS has approved your request, you will receive an
acceptance letter from the IRS with your EFIN.

To view your approved e-file Application to view the EFIN and Tracking Number, do the following:

1. Go to https://www.irs.gov.

2. On the IRS homepage, click Tax Pros in the upper-right portion of the page.

3. Under e-Services, click Access e-Services.​
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4. Under e-file Application, click Go.

5. Enter your username and password and click Login or click Register to create an account.

Note: If you need help logging in, contact the e-help Desk at 1-866-255-0654.

6. If you have multiple organizations that you represent, select the organization for the
Application Summary you want to view. On the Application Landing page, the Tracking
Number for the organization displays. Show me.

7. To open the summary, click View/Edit. The Tracking Number displays at the top of the page.
Show me.

8. To locate the EFIN for the selected organization, scroll down the summary to the EFIN(s)
section. Show me.
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Additional Information
Show me the video (go to the Knowledge Base and search for How do I locate an EFIN and a
Tracking Number).

See Using EFIN Manager on page 74 for information about registering your EFIN and
Tracking Number with Wolters Kluwers.

About the Vendor Control Number (VCN)
Question: What is a Vendor Control Number (VCN)?

Answer: The VCN is a 12-digit number that is transmitted with returns of all tax systems except for
Employee Benefit Plan. A VCN is associated with a specific Electronic Filing Identification Number
(EFIN) to ensure that EFIN is not being used fraudulently by a preparer or firm. The VCN is
generated by Wolters Kluwer and is sent to the IRS along with the associated EFIN. Each return
except for 5500 filed with a specific EFIN must include the VCN associated with that EFIN.

To receive a VCN, your firm must first register the EFIN and the associated Tracking Number with
Wolters Kluwer.

The following steps are required:

1. Obtain the EFIN and Tracking Number. Both the EFIN and Tracking Number are included in
the e-file Application Summary on the IRS e-Services site.

2. Enter the EFIN and Tracking Number in EFIN Manager. Allow approximately 48 hours for the
IRS to validate the EFIN, after which, a VCN is assigned.

3. Obtain the VCN from EFIN Manager.

4. Enter the EFIN and VCN in Office Manager > Electronic Filing Options or the Return
Configuration Set > Electronic Filing Options.
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About the Electronic Return Originator (ERO)
Question: Who is the Electronic Return Originator (ERO)?

Answer: The person or firm that collects the actual return from the taxpayer or firm for the purpose of
electronically filing with the IRS is considered to be the ERO. Officially, the ERO is the person
registered with the IRS as a person authorized to originate electronic return submissions for your
firm.

Corrections to Returns Accepted by the IRS
Question: I have received an acknowledgment indicating my return has been accepted, but I have a
correction to make to the return. Can I make the change with the IRS or DOL?

Answer: No. Once the return has been accepted by the IRS or DOL for processing, you cannot
change the electronic return. You must file an amended return. Some amended returns cannot be
electronically filed. See the IRS website or DOL website for complete information on which amended
returns you can file.

If you are filing a Corporation or S Corporation return, you can also file a superseding return, which is
a subsequent return filed within the filing period.

Note: The IRS recommends that you do not file the amended return until the taxpayer has
received the refund; otherwise, it could slow the refund turnaround time.

Not a Fileable Copy
Question: I printed the paper copy of my return and Form 8879 (8879-PE, 8879-B, 8453-PE, 8453-
B, 8453-F, 8879-F, 8879-C, 8879-S, 8879-EO) was included, but why does it have This is not a
Fileable Copy across the form?

Answer: The form that you receive with the return is for your review only. When you select to export
the return to the Electronic Filing Status System, the electronic version of the return is created and a
fileable copy will print. This copy is the one you file with the IRS.

After creating the electronic version of the return, you can print the form pertinent to the type of return
you are filing electronically using the Selective Pages print option and selecting Form 8879. If the
return is recalculated, the non-fileable message reappears on Form 8879, 8879-PE, 8879-B, 8453-
PE, 8453-B, 8453-F, 8879-F, 8879-C, 8879-S, and 8879-EO until the electronic return is again
created.

Enable Electronic Filing for a Previously Processed Return
Question: I have processed a return and it is ready to file, except that I did not select electronic filing.
How do I add electronic filing to a return that has already been processed?

Answer: To add electronic filing for a return, reprocess it with Interview Form EF-1 or the General >
Electronic Filing worksheet, designating electronic filing for the return included.
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Stop an Unintentional Transmission
Question: I unintentionally transmitted a return. What do I do?

Answer: If you unintentionally transmit a return, see Changing the Status of a Return or Deleting a
Return for information on stopping a return. If the return has already been sent to the IRS or DOL, we
must wait to see if the IRS or DOL accepts it. If it is accepted, there is nothing more we can do. At
this point you may want to contact the IRS or DOL. If the return is rejected, it is not considered a filed
return and can be resubmitted.

For more assistance, call the Electronic Filing Support staff at 1-800-739-9998, option 3.

Client Signature for Reprocessed Returns
Question: Some of my returns were rejected and I have to rerun them for corrections. When I
reprocess, I will receive new authorization forms and a new Form 8879, 8879-C, 8879-S, 8879-PE,
8879-B, 8453-PE, 8453-B, or 8453-F. Does the taxpayer have to sign the new form?

Answer: Probably not. Since most rejected returns can be corrected with a nonsubstantive change,
you can mail the original Form 8879 to the IRS. If the change to the return was substantial, according
to IRS Publication rules, the taxpayer must sign a new form.

Rejection Received on the April Filing Deadline
Question: My Individual return was rejected on the April deadline. Is it considered a late filed return?

Answer: Individual returns transmitted and rejected on the April filing deadline have until midnight
Central Time, 5 calendar days after the original due date to be accepted, meaning that you have five
days to correct a rejected return and release it for retransmission to the IRS. If the return has not
been accepted 5 calendar days after the original due date, you should file a paper return. Include a
note to the IRS with the paper return explaining that the return was filed by the April filing deadline,
but rejected.

Return Rejected Due to Invalid EFIN
Question: I have received my EFIN from the IRS for filing Individual, Partnership, Corporation, and S
Corporation returns and have verified that it is the correct EFIN, but my returns are rejecting because
of a missing or incorrect EFIN. Why is this happening?

Answer: If you received the acceptance letter with your EFIN indicating you have been approved
and your returns are still rejecting with the Missing or Incorrect EFIN, Correct and Resubmit status
code, you should:

Verify that the correct EFIN was entered

Verify the EFIN can be used to file the return type that was rejected.

Contact the IRS before authorizing any more returns for transmission.
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Note: The following rejection status codes also require action relating to the EFIN:

EFIN Disallowed for e-filing. The EFIN utilized has not been provided to Wolters Kluwer, has
been deleted, is marked inactive, or a VCN has not been created. See Validate and Use an
Electronic Filing Identification Numbers (EFIN) on page 92 for more information.

EFIN Mismatch with VCN on File. The EFIN utilized is missing, does not match the EFIN in
EFIN Manager, or does not match the provided VCN. See Using EFIN Manager on page 74 for
information about viewing your firm's EFINs and associated VCNs.
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